NOTICE

The information contained in this document is believed to be accurate in all respects but is not warranted by Mitel Networks™ Corporation (MITEL®). Mitel makes no warranty of any kind with regards to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. The information is subject to change without notice and should not be construed in any way as a commitment by Mitel or any of its affiliates or subsidiaries. Mitel and its affiliates and subsidiaries assume no responsibility for any errors or omissions in this document. Revisions of this document or new editions of it may be issued to incorporate such changes.

No part of this document can be reproduced or transmitted in any form or by any means - electronic or mechanical - for any purpose without written permission from Mitel Networks Corporation.

TRADEMARKS

The trademarks, service marks, logos and graphics (collectively "Trademarks") appearing on Mitel's Internet sites or in its publications are registered and unregistered trademarks of Mitel Networks Corporation (MNC) or its subsidiaries (collectively "Mitel") or others. Use of the Trademarks is prohibited without the express consent from Mitel. Please contact our legal department at legal@mitel.com for additional information. For a list of the worldwide Mitel Networks Corporation registered trademarks, please refer to the website: http://www.mitel.com/trademarks.

© Copyright 2020, Mitel Networks Corporation

All rights reserved
### Managing Phones
- Managing your Desk Phone. ............................................. 26
  - Assigning your Desk Phone. ........................................ 26
  - Customizing your Desk Phone. ................................... 26
  - Removing the Desk Phone Assignment. .......................... 26
- Using the Softphone. .................................................. 26
  - Assigning Softphone. ................................................. 26
  - Customizing the Softphone. ....................................... 27
- Assigning External Phones. ............................................ 27

### Managing Calls
- Making a Voice Call. .................................................. 29
- Answering a Voice Call. ............................................... 30
  - Managing Incoming Call Notifications. .......................... 30
- Exporting Call Data. ................................................... 31
- Answering Call from Call Stack of a Contact. .................... 31
- Viewing Call Interaction History with a Contact. ................ 31
- Transferring a Call. ................................................... 31
  - Transferring a Call Using the Blind Transfer Option. ............... 32
  - Transferring a Call Using the Consult Option. .................... 33
  - Parking a Call. ...................................................... 33
  - Transferring a Call Using the Intercom Option. .................... 34
  - Transferring a Call Using the Whisper Option. .................... 34
  - Transferring a Call to Voicemail. ................................ 34
- Making a Conference Call. ............................................ 35
  - Creating a Blind Conference Call. ................................ 35
  - Creating a Consultative Conference Call. ......................... 35
  - Creating an Intercom Conference Call. .......................... 35
- Managing Call Notes and Viewing Routing Slips. ..................... 36
- Making a Video Call. .................................................. 37
  - Setting Up Video Camera Preferences. ............................ 37
- Managing Voicemail. .................................................. 37
  - Forwarding Calls to your Voicemail Inbox. ....................... 40
  - Leaving a Voicemail Message. .................................... 40
  - Sending a Group Voicemail. ....................................... 40
  - Accessing Voicemail Messages. ................................... 41
  - Viewing Voicemails from a Contact. ............................. 41
  - Listening to a Voicemail Message. ................................. 41
  - Saving a Voicemail Message. ..................................... 42
  - Replying to a Voicemail Message. ................................ 42
  - Forwarding a Voicemail Message. ................................ 42
  - Deleting a Voicemail Message. ................................... 43
  - Restoring a Deleted Voicemail Message. ........................ 43
  - Configuring Email Notifications for Voicemail Messages. ......... 43
  - Managing System Notifications for Voicemail Messages. ......... 43
  - Changing your Voicemail Password. ............................. 44
  - Recording Voicemail Greeting Name. ............................. 44
  - Setting Voicemail Escalation. ..................................... 44
  - Assign Voicemail Escalation Profile to Availability State. ...... 44
  - Playing Envelope Information for Voicemail. ................... 45
Routing Calls. ................................................................. 45
   Availability Routing. ............................................... 45
   Using Power Routing. ............................................. 48
   Routing Calls to Mobile. ........................................ 49
   Customizing your Call Option Settings. ..................... 49

Managing Messages. .................................................. 50
   Viewing Direct Conversation History with a Contact. ..... 50
   Scheduling a Meeting with a Contact Group. ................ 50
   Managing Message Notifications. ............................... 50
   Adding Canned Message Responses. .......................... 51

Integrating with Microsoft Exchange. ............................ 52
   Integrating the Connect client with Microsoft Exchange. . 52
   Synchronizing Events with Microsoft Outlook or Office 365 Calendar. 52
   Synchronizing the Connect client with Microsoft Outlook or Office 365 Contact Folders. 53
   Synchronizing the Connect client Voicemails with Microsoft Outlook or Office 365. 54
   Understanding the Presence Status in Microsoft Outlook. 54

Managing Conferences. ................................................ 55
   Creating a Conference. ........................................... 55
   Editing a Conference. ............................................ 56
      Creating a Conference from Microsoft Outlook. .......... 57
      Creating a Reservation-less Conference. ................. 57
      Adding a new Reservation-less Conference. .............. 58
      Editing a Reservation-less Conference. .................... 58
      Migrating Reservation-less Conferences from ST Communicator. 58
   Viewing Conferences. ............................................ 59
   Downloading the iCalendar Data (ICS) File for a Conference. 59
   Joining a Conference. ............................................ 59
      Joining a Conference from the Dashboard. ............... 60
      Joining a Conference from the Events Tab. .............. 61
      Joining a Conference from Your Calendar. ............... 61
      Joining a Conference from iOS device. ..................... 62
   Placing a Participant on Mute. ................................. 62
   Dropping a Participant from Conference. .................... 63
   Recording a Conference. ........................................ 63
   Canceling a Conference. ........................................ 63
      Canceling a Conference from the Connect client. ....... 63
      Canceling a Conference from Microsoft Outlook. ....... 64
   Conferencing using Connect client for Web. ............... 64
      Using the Connect client for Web. ......................... 64
      Using Group Chat. ........................................... 64
      Using Screen Sharing. ....................................... 65
      Managing System Notification for Screen Sharing Request. 66

Sharing Screen. ....................................................... 67
   Sharing Screens with a Contact. ............................... 67

Managing your Account. ............................................. 68
   Setting a Sound Notification. .................................. 68
   Managing History. ................................................ 68
      Viewing your Interaction History for all Contacts. ..... 69
      Viewing your Interaction History for a Single Contact. 69
### Managing Workgroups

- Workgroups Overview .......................................................... 71
- Workgroups Access Types ..................................................... 71
- Identify Call by Workgroup Name .......................................... 71
- Managing Workgroups .......................................................... 71
- Viewing Workgroups Information ......................................... 71
- Assigning Call Handling Mode Status .................................... 72
- Filtering Queued Calls ......................................................... 72
- Managing Agents ................................................................. 72
- Accessing Workgroups Voicemails ........................................ 73
- Configuring Workgroup Notifications ................................... 74
- Setting Queue Monitor Alert Threshold ................................. 74

### Accessing MiTeam Meetings

- Registering the MiTeam Meetings Account ............................. 75
- Launching MiTeam Meetings from Connect Client .................... 77

### Operator Features

.......................................................... 79
Preface

This preface provides information about the objectives, organization, and conventions used in the User Guide.

- Objectives of this Book
- Conventions

Objectives of this Book

This guide explains how to install, configure, administer, and maintain the Connect client.

Conventions

This guide uses the following advisory notices:

This information is extra, or supplementary.

The following typographical marking conventions are used in this document.

Table 1: Conventions used in the document

<table>
<thead>
<tr>
<th>Marking</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Names of interface objects, such as buttons and menus.</td>
</tr>
</tbody>
</table>
| Blue    | Cross references with hyper-links. Click the blue text to go to the indicated section.  
Note: Table of Contents entries are also links, but they are not shown in blue. |
Installing the Connect Client

This chapter provides information about how to install the Connect client.

- Overview
- Anti-Virus Folders Exclusions
- Installing the Connect Client on Windows OS
- Installing the Connect Client on macOS
- Upgrading Connect Client

Overview

The Connect Client presents a single interface to manage business communications using a ST desk phone, computer, or mobile phone. With support for Microsoft Windows, macOS, and Collaboration for Web, the Connect client simplifies your day-to-day communications and streamlines your work.

Note: You must enable server failover in Connect Client by following these steps:

1. Create two or more servers and add them under one site.
2. Map one fully qualified domain name (FQDN) to each of these servers in the DNS servers.
3. Log in to Connect Client using the FQDN.

Note: While installing or upgrading Connect Client, if you see SMS Agent Host in the Files in Use window, then select either of the following options and click OK to proceed with the installation or upgrade:

- Automatically close and attempt to restart the applications
- Do not close applications. (A reboot will be required.)

Operating System

For Microsoft Windows:
- Microsoft Windows 7 SP1
- Microsoft Windows 8.1
- Microsoft Windows 10

For macOS:
- macOS High Sierra 10.13
- macOS Mojave 10.14

For Windows Server:
- Windows Server 2016, 64-bit (Standard)
- Windows Server 2012, 64-bit (Standard)
- Windows Server 2008 SP2 (Standard)

Minimum Hardware Configuration

For Windows:
- Processor (For Windows 7 and Windows 8)
  - Connect client without Media (only telephony interaction, and call control): Dual Core 1.6 GHz
  - Connect client with Media (includes Softphone and Video): Dual Core 2.4 GHz
- Hard Disk Space: 2GB
- RAM Total: 4GB
- RAM Available: 500 MB

For macOS:
- Processor
INSTALLING THE CONNECT CLIENT

- Connect client without Media (only telephony interaction, and call control): Core 2 Duo 1.83 GHz
- Connect client with Media (includes Softphone and Video): Core 2 Duo 2.4 GHz

- Hard Disk Space: 2GB
- RAM Total: 8GB
- RAM Available: 500 MB

**Supported Servers**

- Microsoft Exchange 2010
- Microsoft Exchange 2013
- Microsoft Exchange 2016
- Microsoft Office 365

**Supported Browsers**

**For Microsoft Windows:**

- Chrome 55.0 and above
- Internet Explorer 11
- Firefox 49.0 and above
- Edge 38 and above

**For macOS:**

- Chrome 55.0 and above
- Firefox 49.0 and above
- Safari 11.0
- Safari 12.0

**For iOS:**

- Safari 11

**Supported Environments**

The supported environments are as follows:

- Citrix XenDesktop 7.6 LTSR
- Citrix XenApp 7.6 LTSR
- Citrix XenDesktop 7.15 LTSR
- Citrix XenApp 7.15 LTSR

**Note:** Softphone is not supported in the Citrix environment.

**Anti-Virus Folders Exclusions**

On your computer, you must exclude the below folders and sub-folders from the Virus Checker software before installing the Connect Client.

**Connect Client**

<Drive>:\Users\%User%\AppData\Local\Mitel
<Drive>:\Program Files (x86)\Mitel
<Drive>:\Program Files (x86)\Mitel Presenter

**Installing the Connect Client on Windows OS**

**Note:** If you have installed the ST Communicator on your computer, the Connect client installer will uninstall the Communicator before installing the Connect client.

1. Do one of the following:
Installing the Connect Client

1. Open the e-mail notification from your Connect administrator that describes how to install the Connect client, and click the link to install the client.

2. In a browser, enter http://<server IP or FQDN>/ShoreWareResources/ClientInstall/default.htm, where FQDN is a fully qualified domain name. Select Connect client, and click Next.

3. On the License Agreement page, select I accept the terms in the license agreement, and click Next.

4. Click Next to install the client in the default folder, or click Change to change the destination folder and continue.

5. On the Ready to Install the Program page, click Install.

6. On the Start menu, click the Connect icon to launch the client.

Installing the Connect Client on macOS

To install Connect Client on macOS, do the following:

1. Do one of the following:
   - Open the e-mail notification from your Connect administrator that describes how to install the Connect client, and click the link to install the client.
   - In a browser, enter http://<server IP or FQDN>/ShoreWareResources/ClientInstall/default.htm, where FQDN is a fully qualified domain name. Select Connect client, and click Next.

   The installation file is downloaded to the default downloads folder on your computer.

2. Double-click the installation file.

3. In the Connect screen, drag the Connect icon into the Applications folder and double-click the icon to launch the client.

Upgrading Connect Client

When a newer version of Connect client is available, you see two kinds of upgrade notifications after you sign in. For more information on signing into Connect Client, see Signing in to the Connect Client on page 10

1. Recommended Upgrade—You can either install or skip the recommended update. However, it is recommended to upgrade if the Connect client is two or more versions behind the latest version. Click Upgrade in the upgrade notification area to get the latest version of Connect client, or click Later to upgrade at a later time.

2. Required Upgrade—You cannot access the application without upgrading. You must upgrade the application or exit if you choose not to upgrade. Click Upgrade in the upgrade notification to get the latest version of Connect client, or click Exit.

   If the upgrade fails, you receive an error notification. Click Exit in the error notification area to exit.
Using the Connect Client

This chapter provides information about how to use the Connect client.

- Signing in to the Connect Client
- Navigating through the Connect Client Interface
- Adding Shortcuts to the Client Toolbar
- Selecting Preferred Language
- Setting a Sound Notification
- Connect Client Logs
- Sharing Data with Mitel

Signing in to the Connect Client

You can sign in to the Connect client using your Connect or Windows credentials.

1. Open Connect client.
   - To login using your Connect credentials, enter your Connect credentials.
     - Email or username
       If your Connect client and Microsoft Exchange email addresses are the same, sign in using your email address to integrate the Connect client with Microsoft Exchange. For more details about integrating the Connect client with Microsoft Exchange, see Integrating the Connect client with Microsoft Exchange on page 52.
     - Password
   - To login using your Windows credentials, click Show Advanced, and select Use Windows Credentials.
     Note: The Use Windows Credentials option is applicable only for MiVoice Connect users on both Windows and macOS.

2. Click Show advanced to view the Domain and Server fields.
3. In the Server field, enter the Fully Qualified Domain Name (FQDN).
4. To save your credentials, select Remember me.
   Note:
   - This option remembers the password only if you exit the application, and not log out. If you log out, you must re-enter the password to sign in.
   - This option fails if the connect client's user name contains only numbers and contains more than 16 digits. To prevent this, either use alphanumeric names or use fewer than 16 digits.

5. Click Login.

To sign out from Connect client, click the drop-down below the <username> on the dashboard, and click Logout.

Depending on how your system is configured, you might need to enter your credentials manually rather than using the Use Windows Credentials check box.

Opening Connect Client Automatically

You can enable Connect client to open automatically when you start the computer.

1. On the dashboard, click the <username> tab.
2. On the second pane, click .
3. Click Account > Login.
4. Select Automatically launch Mitel Connect when starting the computer.

Changing the Password

Note:
You can change your password from the Connect client only when your Connect client is not integrated with Microsoft Exchange. The password automatically changes as you change the password in Microsoft Exchange.

1. On the dashboard, click the `<username>` tab.
2. On the second pane, click .
3. Click Account > Login.
4. Enter:
   - Current password
   - New password
   - Confirm new password
5. Click Set New Password.

If your password is expired, the password expiry notification appears when you sign in. To change the expired password, enter the new password in New password and Retype password fields. Click Save & Login.

Navigating through the Connect Client Interface

The Connect client consists of three panes based on the options you select on the dashboard, as shown in figure.

**Figure 1 : Connect Client Interface**

- **Connect menu bar**—Use the Connect drop-down on the client menu bar to do the following:
  - View information about the Connect.
  - Check for updates.
  - Open the Settings page (for Windows) or Preferences page (for macOS).
  - Show or edit the toolbar.
  - Set the Connect client to be on top while navigating through other applications. For macOS, this option is available in the Window tab on the Mac menu bar.
  - Access the user guide and training videos. For macOS, this option is available in the Help tab on the Mac menu bar.
  - Send log files to the Mitel Support. For macOS, this option is available in the Help tab on the Mac menu bar.
  - Exit the Connect client.
- **Dial Pad**—Use the dial pad to dial a phone number.
- **Quick Dialer Search Bar**—Use the quick dialer search bar to search for a name, number, an email address, or company name.
- **Dashboard**—Dashboard is the default and the main navigation pane:
  - `<username>`—Use the `<username>` tab to view or edit your profile information. If the Connect client is integrated with Microsoft Exchange, it imports your active directory picture which is
associated with the Outlook. For more information about integrating with Microsoft Exchange, see Integrating the Connect client with Microsoft Exchange on page 52.

If you use your active directory picture, you cannot edit or remove it.

- **Contacts**—Use the Contacts tab to view your contacts, add a new contact, create groups, and add contacts to Favorites or Groups.

- **Recent**—Use the Recent tab to view the list of your incoming calls (📞), outgoing calls (打通), and missed calls (未接). It displays the calls in chronological order, with the most recent at the top.

  The date, time, and the call duration are displayed for all incoming and outgoing calls. For the current day’s calls, the time and call duration is displayed. For the previous day’s calls, the word “Yesterday” is displayed along with the time and call duration. For earlier calls, the date, time, and the call duration are displayed.

  The consecutive calls made or received from the same number are grouped together, and the number of calls are displayed next to the contact name. The badge on the Recent tab indicates the number of missed calls.

- **Voicemails**—Use the Voicemails tab to view your new, saved, and deleted voicemails. The badge on the Voicemails tab indicates the number of unheard voicemail messages.

- **Messages**—Use the Messages tab to view your chat logs.

  - **MiVoice Connect users**: Click the Messages Tab to open the conversation details in the third pane. The badge on the Messages tab indicates the number of unread messages.

  - **Events**—Use the Events tab to view your past and upcoming calendar appointments. To view your Outlook appointments, synchronize your Connect client with Microsoft Exchange.

- **Workgroups**—Use the Workgroups tab to view active workgroup calls for a user and the current workgroup state of the user. To view information about workgroups, you must be a member of a workgroup and have the appropriate license type.

  **Note**: The Workgroup feature is available only for MiVoice Connect users.

You can expand or collapse the dashboard view by clicking the up/down arrow icon. In collapsed view, you can mouse hover on each icon to view the tool tip.

**Figure 2 : Dashboard Collapsed View**

- **Second Pane**—The second pane displays information based on what you select on the dashboard. You can resize the second pane manually based on your requirement. This setting is retained on the machine you logged in to if you:
  - Close and reopen the second pane
  - Open the third pane
  - Log out of and then log in to the Connect client
**Note:** If the same user logs in to the Connect client from another machine, the second pane opens with the default settings and all other settings are lost.

- **Third Pane**—The third pane displays information based on what you select on the second pane. For example, if you click a contact on the second pane, the third pane displays the contact card. From the contact card you can access the conversation, calls, and voicemail history along with the information of the contact.

  - **Contact Card**—View and manage the selected contact.
    - **Info**—View the details of the selected contact.
    - **Messages**—View the conversation history of the selected contact and type your messages to the contact.
    - **Calls**—View the call history of the selected contact.
    - **Voicemails**—View the voicemail history of the selected contact. Click the minimize button at the top-right corner of a pane to close the pane.

  **Note:** The third pane is closed automatically if the user clicks any items on the Dashboard. However, if there is any active session on going, that session is not lost and can be viewed on the Dashboard.

**Note:** The badge on the connect client icon on your computer task bar indicates the total number of missed calls and voicemail messages not played. The Connect client icon glows (windows)/bounces (MAC) when you have new missed calls, messages, and voicemails.

### Pinning Tabs for Quick Access

You can pin a tab to the dashboard for quick access. The pinned tab remains open in the second pane with the dashboard. While navigating through the other tabs, you can view the pinned tab in the second pane after you close the open tabs. You can pin only one tab to the dashboard.

To pin a tab to the dashboard:
1. On the dashboard, select the tab.
2. Click icon. To unpin the tab, click icon.

### Connect Client Location

You can set the Connect client to be always on top when navigating through other applications.

**For Windows:**
1. On the client menu bar, click the **Connect** drop-down.
2. Select **Always On Top**.

**For macOS:**
1. On the Mac menu bar, click **Window**.
2. Select **Always On Top**.

### Adding Shortcuts to the Client Toolbar

From the client toolbar, you can add shortcuts for your most used or preferred operations. The configured buttons function as shortcuts to access operations that require more actions to accomplish the same task. You can use these shortcut buttons to perform a one-click operation for monitoring a call, starting a voice recording, opening the agent queue monitor, activating the softphone, or any other option defined by your organization.

To enable this feature, your administrator must first configure the **Client Toolbars** programmable buttons in Connect Director for each user.

The list of configured shortcuts is displayed in a client window. To view or hide the client toolbar from the Connect client, click the **Connect** drop-down on the client menu bar and toggle **Show Toolbar**.

To select which shortcut buttons are displayed in your client toolbar:
1. Click the + icon at the bottom right of the toolbar panel.
2. Select the buttons to add to the toolbar panel.

**Note:** You can add up to 140 buttons to the client toolbar.

You can drag and drop to re-order the buttons. The keyboard shortcuts to the first 10 buttons are auto-assigned based on your order on the client toolbar. For macOS, use CMD+0-CMD+9, and for Windows, use ALT+0-ALT+9 as keyboard shortcuts. You can hover the mouse over the buttons to view the tooltip. For a Monitor Extension button, you can also view the availability state of the extension that you are monitoring.

### Selecting Preferred Language

You can select the language for your desk phone and the Connect client interface.

1. On the dashboard, click the `<username>` tab.
2. On the second pane, click and then click **Language**.

**Note:** If you have an operating system in Spanish, French, German, or Simplified Chinese, the Connect client uses the same language of the operating system. For other languages, the Connect client uses English as the default language. The Mitel collaboration for Web page always uses the same language as that of the operating system, regardless of the language selected in preferences.
3. From the **Deskphone & voicemail menus** drop-down list, select the desired language for your desk phone.
4. From the **I want to use this application in** drop-down list, select the required language for the Connect client interface.

You must exit and restart the client for the change to take effect.

### Setting a Sound Notification

You can create a sound notification to identify a specific event, such as a voicemail, a call from an internal or external number, a monitored call, a shared call, or to identify a new or an existing conversation.

1. On the dashboard, click the `<username>` tab.
2. On the second pane, click 🔔.
3. Click **Notifications > Sounds**.
4. In the **Audio Alerts** field, select **ON**.
5. In the **For event** field, click the drop-down list on the right, and select any of the following:
   - new voicemail
   - call from an internal number
   - call from an external number
   - new message initiating a new conversation
   - new message initiating an existing conversation
   - monitored call
   - shared line call
6. Select **Play alert**, click the drop-down list on the right, and select a required sound from the list.

**Note:** Other than the default list of sounds, you can also add or remove a new `.wav` file.

### Connect Client Logs

The Connect client creates a log file each time you log in. The logs are used to help Technical Support with debugging problems that may arise during the operation. You can send the log files to your Connect Administrator while opening a troubleshooting ticket.

To send the client log files:

- **For Windows:**
  1. On the Connect Menu Bar, click the **Connect** drop-down list.
  2. Select **Send Client Logs** and follow the instructions provided on the screen.

- **For macOS:**
1. On the Mac menu bar, click the **Help** tab.
2. Select **Send Client Logs** and follow the instructions provided on the screen.

**Connect Collaboration web client logs from iOS device**

The Connect Web Collaboration client creates a log file each time you log in from your iOS device. The logs provide data that helps Technical Support troubleshoot issues during the sessions. You can download the log file for a session using your iOS device and attach the file to a ticket.

Following are the steps to access and download the log files for a Connect Web Collaboration client session on your iOS device:

1. Launch the **Connect Web Collaboration client** in Safari on the iOS device.
2. Introduce yourself.
3. On the top left corner of the meeting title, tap and hold the meeting title for 2 seconds.
   - A pop-up dialog box may display depending on your phone setup stating, “This site is attempting to open a pop-up windows” message with Allow and Block buttons.
4. Select **Allow** to open a new page and access the logs from the session.
5. Select **Share**.
6. Select **Create PDF**.
7. Click **Done**.
8. Select **Save file to**.
9. Optional: You can attach the file to an email explaining the issue and send it to Mitel technical support at **itsupport@mitel.com** or to a ticket in the Mitel Global IT Support portal at https://itsupport.mitel.com.

Follow these steps if the popup dialog box does not populate:

1. Select **Share** button.
2. Select **Create PDF**.
3. Click **Done**.
4. Select **Save file to desired location** to save the file in the desired location, such as your local drive.
5. Attach the log to your IT ticket or email to Mitel IT support.

**Sharing Data with Mitel**

The Connect client sends the user interaction data anonymously to Mitel by default. The data is analyzed by technical support for enhancing the Connect client application.

**Note:** All anonymous data is encrypted and cannot be traced back to the user.

To disable sending user interaction data to Mitel:

1. On the dashboard, click the `<username>` tab.
2. On the second pane, click **Account > Access**.
3. Click **Account > Access**.
4. Uncheck the **Yes, I want to help Mitel build better products! Send anonymous data to Mitel** option.

You must exit and restart the Connect client for the change to take effect.
Managing Contacts

This chapter provides information on how to manage your contacts.

- Managing Contacts
- Managing Contact Groups

Managing Contacts

The Connect client enables you to organize and manage your contacts.

To view the system directory that shows all the contacts in your organization, click **Quick Dialer Search**. The contact names with special characters and numbers are displayed first, and followed by names in the alphabetical order by the last name with alpha headers.

To find a contact, type any of the following in the **Quick Dialer Search** field:

- First Name
- Last Name
- Email address
- Company name
- Extension number
- Double token (single letter and double letter of the contact’s name). For example, you can type P R or Pa Ro to search for Patrick Roberts.

**Managing Contacts** describes the process of adding a contact and viewing the contact’s information.

**Figure 3 : Managing Contacts**

**Adding a Contact on macOS**

1. Do one of the following:
   - Click the **Recent** tab, right-click the contact, and select **Add As a Contact**.
   - Click the **Contacts** tab and click at the top right corner of the second pane, and then select **Add Contact**.
The address book contact form is displayed.

**Note:**

The address book opens only if you have enabled the Connect client in the System Preferences on your Mac.

2. Type the contact details in the required fields.
3. Click **Done**.

You can add an external number to your contact list from the contact card:

1. Type the external number in the **Search** field, and the contact card opens in the third pane.
2. Click ☎️ on the Avatar in the third pane.

### Adding a Contact on Windows

You can add a new contact using the Microsoft Outlook contact form and the Connect client contact form.

**Note:**

You can add a new contact through Outlook contact form only if:

- Your Connect administrator has configured the Microsoft Exchange account on the Connect Director.
- Microsoft Outlook is installed on your computer.

To add contact using the Microsoft Outlook contact form:

1. Do one of the following:
   - Click the **Recent** tab, right-click the contact, and select **Add As a Contact**.
   - Click the **Contacts** tab and click ☀️ at the top right corner of the second pane, and then select **Add Contact**.
     
     An Untitled Outlook Contact form is displayed.

2. Type the contact details in the required fields.
3. Click **Save & Close**.

**Note:**

If you have installed the Microsoft Outlook on your computer, the Outlook contact form opens by default when adding a new contact. However, you can set the Connect client to open the Connect contact form instead of Outlook contact form.

To open the Connect contact form instead of Outlook contact form when adding a contact:

1. On the dashboard, click the `<username>` tab.
2. On the second pane, click ☀️ and then click **Outlook**.
3. Select **Do not open Outlook when adding contact to Connect**.

To add a new contact using the Connect contact form:

1. Do one of the following:
   - Click the **Recent** tab, right-click the contact, and select **Add As a Contact**.
   - Click the **Contacts** tab and click ☀️ at the top right corner of the second pane, and then select **Add Contact**. The Contact form opens in the third pane.

2. Type the contact details in the required fields.
3. Click **Add Contact**.

### Adding an External Contact on Windows

You can add an external contact to your contact list from the Connect Client:

1. Click the **Recent** tab, select the number in the second pane, click ☎️ at the top left corner of the third pane and the **Create Contact** page is displayed.
2. Type the number in the Search field, click ☎️ at the top left corner of the third pane and the **Create Contact** page is displayed.
3. Type the contact details in the required fields.
4. Click Create.

**Note:**
You cannot add any external number using Microsoft Outlook contact form.

**Viewing Information of a Contact**

1. In the Quick Dialer Search bar, type the contact name or extension number and select the contact.
   - By default, the system directory search results are displayed.
   - If you have enabled the Enable searching for contacts in my exchange public contact folders option, you can view the search results from Direct Matches and Exchange Public Matches.
     - By default, the Connect client displays the search results from Direct Matches.
     - To search for a contact from your Exchange Public folders, click Exchange Public Matches. From the drop-down list, select the folder, and the contact.
       The Contact card opens on the third pane.
       **Note:** For more information about the Enable searching for contacts in my exchange public contact folders option, see To enable searching for the contact from the Exchange Public Contact folders:

2. On the Contact card, click **Info** to view the contact’s details.

To see the company name, department name, and phone number of a contact:

- From the Quick Dialer Search bar:
  a. Right-click the contact on the second pane.
  b. Select the Show Company Name, Show Department Name, and Show Phone Number options to view or hide the contact information.
- From **Favorites** and **Groups**:
  a. On the second pane, click ☰.
  b. Select the Company Name, Department Name, and Phone Number options to view or hide the contact information.

The phone numbers of the contact are displayed in the order: Extension ( ), Business or Work ( ), Mobile ( ), and Home ( ). If a contact has configured all the four phone numbers on the Connect client, by default, the first two phone numbers in the order get displayed in the second pane.

To view all the phone numbers, click **More**. The Contact card opens on the third pane. Click Info where all the phone numbers and email id of the contact are displayed.

**Note:** The More option is displayed only if the contact has configured more than two phone numbers.

**Importing the Contact Folders**

For macOS, you can import the contact folders from the Mac address book into the Connect client. If the Microsoft Outlook is installed on your computer, the Mac address book synchronizes with the Microsoft Outlook or Office 365 contact folders.

**Note:** You must enable the Connect client in the System Preferences on your Mac to import the contacts from the Mac address book.

To import the contact folders from the Mac address book:

1. On the dashboard, click the <username> tab.
2. On the second pane, click ☰.
3. Click **Contacts/Outlook**.
4. Select Sync my Mac Contacts option.
5. Click +Show contact folders and select the folders that you want to import into the Connect client.

For Windows, if you have integrated the Connect client with Microsoft Exchange, you can import the contact folders from Microsoft Outlook or Office 365 into the Connect client. For information about importing the contact folders from Microsoft Outlook or Office 365 into the Connect client, see Synchronizing the Connect client with Microsoft Outlook or Office 365 Contact Folders on page 53.
**Editing an External Contact**

To edit an external contact, follow these steps:

1. In the **Quick Dialer Search** field, type the contact name or the number.
2. From the search results, click the contact name that you want to edit.
3. The contact card opens in the third pane, click **Info** on the contact card.
4. Click **Edit**, and update the fields.
5. Click **Save** to confirm the update.

**Deleting a Contact**

To delete a contact from Connect client when it is not integrated with Outlook:

1. In the **Quick Dialer Search** field, type the contact name or extension.
2. Click the name of the contact that you want to delete.
3. Click **Info** on the contact card.
4. Click **Delete**.
5. In the confirmation dialog box, click **Delete**.

**Note:** You can delete only the external contacts that you have added to the Connect client. However, you cannot delete contacts available through the system directory of your organization.

You can delete the contacts imported from the Outlook all at once using the Connect client interface.

To delete the contacts imported from Outlook:

1. On the dashboard, click `<username>` tab.
2. On the second pane, click ☀️ and then click **Outlook**.
3. Click **Remove Synced Contacts**.
4. In the confirmation dialog box, click **Remove**.

All your contacts imported from Outlook are deleted at once. The **Remove Synced Contacts** option is disabled and the **Sync my Outlook contacts** option is cleared.

**Deleting an External Contact**

1. In the **Quick Dialer Search** field, type the contact name or number.
2. From the search results, click on the contact name that you want to edit.
3. The contact card opens on the third pane, click **Info** on the contact card.
4. Click **Delete**.
5. In the confirmation dialog box, click **Delete**.

**Adding a Contact to your Favorites List**

1. In the **Quick Dialer Search** field, type the contact name or extension.
2. From the search results, click the **Star** icon next to the contact name that you want to mark as favorite.

   Alternatively, you can mark a contact as favorite by clicking the **Star** icon on the Avatar in the third pane.

   You can mark a contact favorite from both Direct Matches and Exchange Public Matches.

To remove the contact from the favorites list, click the **Star** icon next to the contact name or on the Avatar.

**Viewing Favorites**

1. Click the **Contacts** tab on the dashboard.
2. Click the **Favorites** tab on the second pane to view the list of contacts marked as favorites.

In Favorites and Groups lists, you can see the contacts in **List** mode and **Compact** mode. On the second pane, click ‼️ to view in List mode, and click to view in Compact mode.

- **List Mode:** The contact’s name, extension number, phone number, department name, and availability status are displayed.
• **Compact Mode:** The contact’s name and availability status are displayed.

**Searching Contacts**

You can search the contacts added to your Favorites or Group. To search a contact, enter the contact’s name, or extension in the Search field in the Favorites or Group tab.

The search results open on the second pane displaying the contact’s name, availability status, extension number, and phone number.

If the contact is online and has set an additional note to the availability status, the additional note is displayed. If the contact is offline, the availability status is unknown.

For more details about viewing information of a contact, refer to Adding an External Contact on Windows on page 17.

**Sorting Contacts**

You can sort the contacts in your Favorites and Groups list by last name, first name, availability state, and last contact.

To sort your contacts in Favorites or Groups:

1. On the dashboard, click **Contacts > Favorites**.
2. On the second pane, select **Favorites** or **Groups**.
3. Click and select one of the following:
   - Last Name
   - First Name
   - Availability
   - Last Contact

**Viewing Call Stack Information of a Contact**

You can view the availability state and call stack information of a contact if the contact is added to your Favorites or Groups list. To view the call stack information, do one of the following:

• Click **Contacts > Favorites or Groups**. Hover on a contact to view the tool tip. Tool tip displays the contact’s availability state and call stack information.

• Open the contact card and click at the top right corner of the contact card to view the contact’s availability state and call stack information.

   If the contact has included an additional note to the availability status, the additional note will be displayed instead of the default status.

You can answer the Incoming calls, Parked calls, and On Hold calls from the contact’s call stack. To answer a call from the call stack of a contact, refer to Exporting Call Data on page 31

**Managing Contact Groups**

**Creating a Contact Group**

1. On the dashboard, click **Contacts > Groups**.
2. On the second pane, click and select **Add Group**.
3. In the **Group Name** field, type the group name.
4. In the **Group Members** field, do one of the following:
   - Type the contact name and select the contact.
5. In the **Quick Dialer Search** field, type the contact name or number, and then drag the contact from the search results to the **People** field.
   - **Note:** You can use the **More** option to list the complete members for larger numbers.
6. Click **Create** to save the group, or **Discard**.
Reordering the List of Contact Groups

1. Click the **Contacts** tab on the dashboard.
2. Click the **Groups** tab to view all the groups created.
3. Click the group header and drag it to the required position.

Any changes to the order of groups is persistent between the client restarts.

You can hide or view members for a particular group. Click **expand/collapse** on the group header to expand or collapse the group.

**Note**: When you log in after logging out, the groups under the **Groups** tab are displayed as expanded or collapsed as they were during the previous login.

Editing or Deleting a Contact Group

1. On the dashboard, click **Contacts > Groups**.
2. Click **expand/collapse** on the group header you want to edit.
3. Click **edit** next to the group name.
4. In the **Group Name** field, edit the group name.
5. In the **Group Members** field:
   - To add a contact to the group, enter the contact name and select the contact. **Note**: Enter the contact name or the number in the **Quick Dialer Search**, and right-click the contact on the second pane, and select **Add Contact to Group** field to add the contact to the required group.
   - To remove a contact from the group, click **X** next to the contact.
   - To reorder the contact names, select a contact, drag the selected contact to the required order.
6. Click **Save** to save your changes, or click **X** at the top-right corner of the third pane, and in the confirmation dialog box, click **Discard** to remove the user changes.

To delete a group, do the following:

1. On the dashboard, click **Contacts > Groups**.
2. Click **expand/collapse** on the group header you want to delete. The group expands in the third pane.
3. Click **edit** next to the group name in the third pane, and click **Delete**.
4. In the confirmation dialog box, click **Delete** to confirm the group deletion.
Managing Availability States

This chapter provides information about managing availability states for users and their contacts.

- Understanding Availability States
- Changing Availability State
- Allowing a Contact to Manage your Availability State

Understanding Availability States

You can check or verify the availability status of a contact on the Connect client before communicating with that contact. The Connect client automatically updates the availability status of users as they make and receive calls. When integrated with Microsoft Exchange, the Connect client also displays users’ meeting status.

You can monitor the availability of up to 500 contacts. This can be configured by your Connect administrator.

The different availability states are described in Availability States.

Table 2: Availability States

<table>
<thead>
<tr>
<th>Color</th>
<th>State</th>
<th>Predefined/Customizable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Available</td>
<td>Predefined</td>
<td>The contact is available for a call or IM session.</td>
</tr>
<tr>
<td>Yellow</td>
<td>In a Meeting</td>
<td>Predefined</td>
<td>The contact is in a meeting, but you can still reach the contact through an IM session. If you dial this contact, the call will be routed to the contact's voicemail inbox or to the number configured using the availability routing, as explained in Playing Envelope Information for Voicemail on page 45.</td>
</tr>
<tr>
<td>Red</td>
<td>Out of Office</td>
<td>Predefined</td>
<td>If you dial this contact, the call will be routed to the contact's voicemail inbox or to the number configured using the availability routing, as explained in Playing Envelope Information for Voicemail on page 45.</td>
</tr>
<tr>
<td>Color</td>
<td>State</td>
<td>Predefined/Customizable</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>---------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Red</td>
<td>Do Not Disturb</td>
<td>Predefined</td>
<td>The contact is busy and does not wish to be reached. However, you can reach this contact through an IM. If you dial this contact, the call will be routed to the contact’s voicemail inbox or to the number configured using the availability routing, as explained in <strong>Playing Envelope Information for Voicemail</strong> on page 45.</td>
</tr>
<tr>
<td>Red</td>
<td>Vacation</td>
<td>Predefined</td>
<td>If you dial this contact, the call will be routed to the contact’s voicemail inbox or to the number configured using the availability routing, as explained in <strong>Playing Envelope Information for Voicemail</strong> on page 45.</td>
</tr>
<tr>
<td>Gray</td>
<td>Custom</td>
<td>Customizable</td>
<td>The contact has a custom status, depending on the configured option. If you dial this contact, the call will be routed to the contact’s voicemail inbox or to the number configured using the availability routing, as explained in <strong>Playing Envelope Information for Voicemail</strong> on page 45.</td>
</tr>
<tr>
<td>Orange</td>
<td>Ringing</td>
<td>Predefined</td>
<td>When you receive an incoming call, the availability state flickers and changes to orange.</td>
</tr>
<tr>
<td></td>
<td>On the Phone</td>
<td>Predefined</td>
<td>When you answer an incoming call, the availability state changes to orange. When you are already on a call and receive another incoming call, the availability state starts flickering and changes to Ringing.</td>
</tr>
</tbody>
</table>
Setting Alert for Contact’s Availability State

If you want to communicate with a contact who is currently not in Available state, you can set the Connect client to notify you when the contact’s status changes to Available.

To receive a notification do either of the following:

1. In the Quick Dialer Search field, enter the contact name or extension, and select the contact. In Contact Card, click and select Alert When Available.
2. If the contact is added to your Favorites or Groups list, right-click the contact in Favorites or Groups tabs, and select Alert When Available.
3. In the Quick Dialer Search field, enter the contact name or extension, right-click the contact in second pane, and select Alert When Available.

A notification appears on the dashboard alerting you when a contact becomes available.

Figure 4 : Alert when Available notification

You can set the alert only for the contacts available through the system directory of your organization. However, you cannot set this alert for any external contacts that you have added to the Connect client.

Note: Alerts are disabled when the Connect client restarts or quits.

Changing Availability State

The Connect client automatically updates your availability state when you use the system, but you can select a predefined availability state or configure a custom availability state.

Selecting a Predefined Availability State

1. On the Dashboard, click the drop-down menu below the <username>.
2. Select one of the following availability states:
   - Available
   - In a meeting
   - Out of office
   - Do not disturb
   - On vacation
A check mark ✓ is displayed next to the current set state.

**Adding a Note to Availability States**

You can add a custom note to each availability state on Connect client. To add or edit an availability state note:

1. In the drop-down, hover over the selected availability state, and click 🖊.
2. In the Additional Note field, enter the description. You can enter description up to 50 characters.
3. Click **Done** to save the changes, or **Cancel** to discard.

If you do not want to add or edit the note, click **Back** to go back to the availability state drop-down menu.

**Configuring a Custom Availability State**

1. On the Dashboard, click the drop-down menu below the <username>.
2. In the drop-down, click **Custom** and select one of the availability state color:
   - Green - Available
   - Yellow - Busy
   - Red - Not available
   **Note:** The color of the availability state cannot be customized.
3. Enter your custom status. Click **Done** to save changes, or **Cancel** to discard. Click **Back** to go back to the availability state drop-down menu.

The custom availability status and color is displayed on the <username> tab.

**Note:** To view your availability state in Microsoft Outlook after integration with the Connect client, ensure that you launch the client before launching Outlook on Windows.

**Allowing a Contact to Manage your Availability State**

You can configure a contact to manage your availability state on the Connect client. To manage your availability state, the contact must meet the following requirements:

- The contact must have added you to a contact group.
- The contact must have a Workgroup Supervisor or Operator license type and be configured with a specific class of service in Connect Director.

To allow access to a contact to manage your availability states:

1. On the Dashboard, click the <username> tab.
2. On the second pane, click ☑️.
3. Click **Account > Access**.
4. Enter in the contact name for whom you want to allow access, and close the page. The contact is configured to change your availability state until you revoke access by removing the contact from the **Access** page.
Managing Phones

This chapter provides information about managing your desk phone, softphone, and external phones.

- Managing your Desk Phone
- Using the Softphone
- Assigning External Phones

Managing your Desk Phone

This section provides information about assigning a desk phone to your Connect client.

Assigning your Desk Phone

1. On the desk phone, press the Assign soft key.
2. In the Extension field, enter your assigned extension number, and press Next or the down key.
3. In the Voicemail password field, enter your voicemail password, and press OK or the # key.
4. Verify the desk phone status in the Connect client as follows:
   a. Launch the Connect client.
   b. Verify the status on the dashboard:
      - If the deskphone is successfully assigned, is displayed on the dashboard next to the <username>.
      - If the Desk Phone icon is not displayed, then repeat steps 1 to 3.
   c. Verify the desk phone status on the second pane:
      - Click the <username> tab to display the second pane.
      - In the Primary Assignment tab, verify if the Desk phone option is displayed.

Customizing your Desk Phone

1. On the Dashboard, click the <username> tab.
2. On the second pane, click .
3. Click the Deskphone tab to display the desk phone options.
   - In the Wallpaper field, in the drop-down list, select the preferred wallpaper.
   - In the Ringtone field, in the drop-down list, select the preferred ringtone.

Removing the Desk Phone Assignment

1. On the Dashboard, click the <username> tab.
2. Click the Primary Assignment tab.
3. To reset the current extension assignment, click Go Back To My Desk Phone.

The Deskphone option is removed from the Primary Assignment tab. The corresponding extension number is also unassigned from the desk phone.

Using the Softphone

When you select softphone as your primary assignment, incoming calls are routed to the Connect client. The desk phone functionality is disabled until you assign your desk phone again to the Connect client.

Assigning Softphone

1. On the Dashboard, click <username>.
2. In the Primary Assignment tab, select softphone.
   Note: If the Softphone option is not displayed, contact your Connect administrator.
3. Select one of the following from the drop-down list:
• Default
• Communications
  Communications device option is available only in Windows.
• Microphone
• Headset Microphone
  The Headset option is shown in the drop-down list only after you plug a headset into your computer.

After the softphone is successfully assigned, is displayed on the dashboard next to the <username>.

Customizing the Softphone

1. On the Dashboard, click the <username> tab.
2. On the second pane, click .
3. Click the Softphone tab to display the softphone options.
   Note: If you do not see the Softphone tab, contact your Connect administrator.
4. To switch to a different audio device, in the Capture audio through field, click the drop-down list, and select the preferred audio device.
   Note: If required, plug your audio device into the computer’s headset port or use the computer’s built-in speakers.
5. Select On startup assign me to my softphone to handle calls and voicemails on the softphone from the time you first log in to the client.
6. Select Enable auto gain control to enable the automatic control.

Note: The Connect client softphone supports a variety of Plantronics and Jabra headsets. For details, search the Mitel knowledgebase at the following location:
• For Customers: https://mitelcommunity.force.com/customer/
• For Partners: https://mitelcommunity.force.com/partner/

Assigning External Phones

Note:
The Connect administrator can enable, disable, or configure the external assignment option from Connect Director.

1. On the Dashboard, click the <username> tab.
2. Select External Assignment Number.
3. In the Add Label field, enter a name for the number. For example, Home or Mobile.
4. In the Add Number field, enter the phone number.
   Note:
   • If you enter the format of the number incorrectly, the Cannot save this number pop-up message is displayed.
   • You cannot use a phone number that is assigned to Connect for iOS or Android.
5. In the Number of Rings field, select a number from 1 through 20. By default, the number of rings is set to 3.
6. To choose a method to connect to the external number, click the drop-down list and select one of the following:
   • Automatically connect
   • Press 1 to connect
7. Click Add.

After the external number is successfully assigned, is displayed on the dashboard next to the <username> tab.

To add a new number, click Add New Number.

To delete a number, select the number from the drop-down list and click Edit. In the Edit Number field, click Remove to delete, or click Keep Number to retain it.
If you have more than one external number, you must select one number from the drop-down list to assign to the Connect client.

**Note:** You can add up to seven external numbers, and assign your extension to any one number.

You can select the number of rings after which you want the calls to be routed to voicemails.

1. On the dashboard, click the `<username>` tab.
2. On the second pane, click ☰.
3. Click **Call Routing > Availability Routing**.
4. Click **Change** next to the **rings before incoming calls are routed** to the voice mail routing option.
5. Select 6 or more rings from the **rings before forwarding** drop-down list.
6. Click **Save**.
Managing Calls

This chapter provides information about making voice calls and using related features in the Connect client.

- Making a Voice Call
- Answering a Voice Call
- Exporting Call Data
- Answering Call from Call Stack of a Contact
- Viewing Call Interaction History with a Contact
- Transferring a Call
- Making a Conference Call
- Managing Call Notes and Viewing Routing Slips
- Making a Video Call
- Managing Voicemail
- Routing Calls
- Customizing your Call Option Settings

Making a Voice Call

You can make a call from:

- Quick dialer search bar
- Directory
- Recent
- Dial pad

To make a call from the quick dialer search bar or from the system directory:

1. Type the contact details in the quick dialer search bar on the dashboard.
   
   Enter the first or last name, extension, company name, department name, phone number, or an email address of the person you would like to search for. For more information about searching for a contact, refer to Adding an External Contact on Windows on page 17.

2. Do one of the following:
   
   - Double-click the contact in the second pane.
   - Click the contact, and click in the third pane, which dials the default number of the user.

   If the user has configured more than one number, to call the user at a particular number, click in the third pane, and select the number.

   1. Click the Recent tab on the dashboard.
   2. Do one of the following:

   - Double-click the contact in the second pane.
   - Click the contact, and click in the third pane.

To make a call from the dial pad:

1. Click on the dashboard.
2. Enter the extension or the mobile number, and press enter.
Answering a Voice Call

The Connect client displays a call notification on the dashboard for every incoming call. If you have enabled the system notification for incoming calls, the Connect client also displays a system notification with the following information:

- **Name of the Contact.** If the caller is not listed in the system directory of your organization, the name is displayed as Unknown.
- **Phone Number**
- **Dialed Number Identification Service (DNIS) if available**
- **Huntgroup or Workgroup name,** if the caller belongs to any. This is applicable only for MiVoice Connect users.

Note: To enable the system notification for an incoming call, see Managing Incoming Call Notifications on page 30.

To answer an incoming call, do one of the following:

- **On the system notification,** click **Accept** to answer or **Ignore** to send the call directly to voicemail.
  
  **Note:** For users with Extension only license, only the **Accept** option is displayed on the system notification.

- **On the Dashboard,** click **** to answer, and click to directly transfer the call to voicemail. To reject the call and respond through IM, click **Send** and type the message or select the canned message, and click **Send.** Click **** to end the active call.

- **To answer a call using the Plantronics headset:**

  **Note:** You must install the Plantronics hub. If you do not install the Plantronics hub or the hub is down, the headset acts as a normal audio device, and you cannot use the headset buttons to perform call functions. To download and install the Plantronics hub software, refer to the Plantronics website.

  - Set your extension to Softphone. (For more information, see Assigning Softphone on page 26.)
  - Press the call answer option on your headset.

    You can use the call control functions available on your headset. For more information, refer to the Plantronics website.

    You can place a voice call on hold and resume when required.

    - In the call notification area, click to place the call on hold and click to resume.
    - On the contact card, click to place the call on hold and click to resume.

  **Note:** If you are unable to release a call placed on hold from Connect Client, check and ensure that the Shared Call Appearances (SCA) option under Users > Telephony > Ensure shared call appearances is disabled.

You can send a call note on an active call. For more information about adding a call note, see Managing Call Notes and Viewing Routing Slips on page 36.

Managing Incoming Call Notifications

To receive a system notification for an incoming call:

1. **On the Dashboard,** click the **<username>** tab.
2. On the second pane, click .
3. Click **Notifications > Popup.**
4. **To enable notifications,** select the **Show a system notification for an incoming Call** check box.
5. In the **Keep notification on screen for** field, select the time from the drop-down list.
Exporting Call Data

Users can export the call history details and the associated call notes by using the ‘Export Call Data’ feature. To export the call data, do the following:

1. Click the Recent tab on the dashboard.
2. Under the All tab in the second pane, click 
3. Use the drop-down menu to do the following:
   - **Today** - Export the entire call history with the contacts for the present day.
   - **Last week** - Export the entire call history with the contacts for the last seven days.
   - **Last month** - Export the entire call history with the contacts for the last month.
4. Select Export from the drop-down menu. *Note: The Save As dialog box is displayed. The default file format is .csv, and the default path for saving the file is C:\Users\<user>\Downloads.]*
5. Enter the file name, and select the location or accept the default location, and click Save.
6. Locate the file on your computer, and double-click to open the .csv file, or you can rename the file in the .xlsx format and open it.
7. Review the information about the call data.

Answering Call from Call Stack of a Contact

*Note:* This option is available only if your Connect administrator has enabled the Allow Call Pick Up option in Connect Director.

You can answer incoming calls, parked calls, and calls on hold from a contact’s call stack. To answer a call:

1. View the call stack of a contact. For information about call stacks, see Viewing Call Stack Information of a Contact on page 20.
2. Click beside the call you want to answer. *Note: When you answer a call from the contact’s call stack, the answered call is removed from the contact’s call stack and appears on your call stack.*

*Note:* You can also answer the parked calls from the contact card. Click , in the pop-up window click to answer the call.

Viewing Call Interaction History with a Contact

1. In the Quick Dialer Search field, type the name or extension number and select the contact.
2. In the third pane, click Calls.

In the drop-down, by default, All is selected. It displays the entire call history with the contacts. To view only the missed calls, select Missed in the drop-down.

Your call history with the selected contact is displayed in the third pane. Click each call entry to view the call origin, the call duration, the call routing slip, and to enter a call note.

Transferring a Call

The Connect client allows you to do the following kinds of transfer operations or other actions related to transfers:

- Blind Transfer
- Consultative transfer
- Park
- Intercom
- Whisper
- Voicemail
describes the different types of call transfer options; Transfer, Consult, Park, Intercom, Whisper, and Voicemail options.

**Figure 5 : Transferring a Call**

Transferring a Call Using the Blind Transfer Option

In Blind Transfer, you cannot talk to the person that you want to transfer the call to, prior to making the call transfer. You can do the blind transfer using the drag and drop option, the contextual menu, and from the call notification area.

**Note:** You can do the blind transfer either before or after answering a call. To answer a call, see **Answering a Voice Call** on page 30.

To do a blind transfer using the drag and drop option:

1. In the **Quick Dialer Search** field, enter the contact name or the extension number.
2. On the Dashboard, drag the call from the call notification area and drop it on the contact in the second pane.

To do a blind transfer using the contextual menu:

1. In the **Quick Dialer Search** field, enter the contact name or the extension number.
2. Drag the call from the call notification area and hover over the contact for two seconds to view the contextual menu. Select **Blind transfer** from the contextual menu to complete the call transfer.

**Note:** Under **Groups** and **Favorites** if the contact list is long, you can drag the call to the list and scroll through the list to locate the contact to whom you want to transfer the call.

To do a blind transfer from the call notification:

- Before answering the call:
MANAGING CALLS

1. On the dashboard, click in the call notification.
2. In the second pane search field, type the contact name or the phone number.
3. Click Transfer.

After answering the call:

1. In the second pane, click .
2. In the second pane search field, type the contact name or phone number.
3. Click Transfer.

Transferring a Call Using the Consult Option

In consultative transfer, you can talk to the person that you want to transfer the call to, prior to making the call transfer.

• Before answering the call:

1. On the Dashboard, click in the call notification.
2. In the second pane search field, type the contact name or the phone number.
3. Click Consult.
4. In the Consulting window, click to complete the call transfer.

• After answering the call:

1. In the second pane, click .
2. In the second pane search field, type the contact name or phone number.
3. Click Consult. The active call goes on hold and the Consulting window appears.
4. Click to complete the call transfer.

Parking a Call

You can park a call using the contact card or the contextual menu. If the call is not answered at the specified extension, the call is returned to you with the routing slip indicating that you have already spoken to this caller.

To park a call using the contact card:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 30.)
2. In the second pane, click .
3. In the second pane search field, type the contact name or phone number.
4. Click the Park option.
5. Click to park the call.

To park a call using the contextual menu:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 30.)
2. In the Quick Dialer Search field, enter the contact name or number and select the contact.
3. Drag the active call in the notification area and hover over the selected contact for two seconds to view the contextual menu.
4. Select Park from the contextual menu to complete the call transfer.

appears next to the contact name indicating that the call is parked on the contact’s call stack.

Park and Page

To park a call and page a contact:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 30.)
2. In the second pane, click .
3. In the second pane search field, type the contact name or phone number.
4. Click the Park option.
5. Click to park and page the call.

Park and Intercom

You can use the park and intercom option to place an intercom call in which the recipient phone automatically answers with mute activated and broadcasts your message through the recipient’s speaker phone, headset, or handset.

To park and intercom a call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 30.)
2. In the second pane, click .
3. In the second pane search field, type the contact name or phone number.
4. Click the Park option.
5. Click to park the call and place an intercom call to the selected contact.

Transferring a Call Using the Intercom Option

Before answering the call:

1. On the Dashboard, click in the call notification.
2. In the second pane search field, type the contact name or the phone number.
3. Click Intercom.
4. On the Consulting window, click to complete the call transfer.

After answering the call:

1. In the second pane, click .
2. In the second pane search field, type the contact name or phone number.
3. Click Intercom. The active call goes on hold and the Consulting window appears.
4. Click to complete the call transfer.

Transferring a Call Using the Whisper Option

Before answering the call:

1. On the Dashboard, click in the call notification.
2. In the second pane search field, type the contact name or the phone number.
3. Click Whisper.
4. On the Consulting window, click to complete the call transfer.

After answering the call:

1. In the second pane, click .
2. In the second pane search field, type the contact name or phone number.
3. Click Whisper. The active call goes on hold and the Consulting window appears.
4. Click to complete the call transfer.

Transferring a Call to Voicemail

On the dashboard, click in the call notification to transfer the call directly to your voicemail without answering the call.

To transfer the call to another contact’s voicemail:

1. On the Dashboard, click in the call notification to answer the call.
2. In the second pane, click 📻.
3. In the second pane search field, type the contact name or phone number.
4. Click Voicemail. The active call goes on hold and the Consult window appears.
5. Click to complete the call transfer to voicemail.

Making a Conference Call

A conference call involves more than two parties connected in a call. The number of people you can conference together in a call depends on your system configuration. Contact your Connect administrator for the details about your system’s conference capabilities.

You can set up a conference call using either of the following approaches:

• In a blind conference call, you conference the people together without the other person first answering your call.
• In a consultative conference call, you talk to the person before adding that person to the conference call.

Creating a Blind Conference Call

To do a blind conference using the contact card:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 30.)
2. In the second pane, click 📻.
3. In the second pane search field, type the contact name or extension and click Conference.

To do a blind conference using the contextual menu:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 30.)
2. In the quick dialer search bar, type the contact name or number and select the contact.
3. Drag the active call in the notification area and hover over the selected contact for two seconds to view the contextual menu.
4. Select Conference Blind from the contextual menu to initiate the conference.

Creating a Consultative Conference Call

To do a consultative conference call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 30.)
2. In the second pane, click 📻.
3. In the second pane search field, type the contact name or extension and click Consult. The active call is placed on hold automatically, allowing you to consult the third person.
4. Click to initiate the conference call.

Creating an Intercom Conference Call

You can add a participant to an active call by placing the active user on hold and then using the intercom conference feature to call the third user without ringing the phone line.

To do an intercom conference call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 30.)
2. In the second pane, click 📻
3. In the second pane search field, type the contact name or extension and click Intercom. The active call is placed on hold, and the call to the third user is automatically answered on the phone line.
4. Click icon to initiate a conference call.
Managing Call Notes and Viewing Routing Slips

Call note allows you and the other members on the call to add, view, and edit notes for an incoming call, a call that is on hold, and an active call.

Routing Slips displays the history and call routing details of the call.

Call Note and Routing Slip Status describes the various call note and routing slip status for an incoming call, call on hold, and active call.

Table 3: Call Note and Routing Slip Status

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Indicates that the return routing slip is open. This icon is displayed when the call that you parked is returned to you and when the routing slip is open.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Indicates that the return routing slip is closed. This icon is displayed when the call that you parked is returned to you and when the routing slip is closed.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Indicates that the routing slip is closed. To open, click the icon.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Indicates that the routing slip is open. If there is only one call, by default, the routing slip of the call is open. If there are multiple calls, by default, the routing slip is open only for the oldest call on the dashboard. For the other calls, click the icon to open the routing slip.</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Indicates that the call note is closed and there is no text. To open, click the icon. You can add the text to the call note.</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Indicates that the call note is open and there is no text. You can add the text to the call note.</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Indicates that the call note is closed and it has text. To open, click the icon. You can then view or edit the text.</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Indicates that the call note is open and it has text. You can view or edit the text.</td>
</tr>
</tbody>
</table>

To enable routing slips and call notes:

1. On the Dashboard, click the `<username>` tab.
2. On the second pane, click 🔄.
3. Click Telephony.
4. Select **Show access to routing slip and call note for each call in the dashboard**. The call stack displays routing slip and call note icons.

You can click 📞 to view or hide the routing slip and click 📊 to view or hide the call note for a call. You can also edit the previous call note during an active call.

**Note:** By default, the routing slip is open for the oldest call on the dashboard. For the other calls, click 📞 to open it.

**Making a Video Call**

To make a video call, the Primary Extension must be assigned to your Softphone. (For details about how to assign your extension to the softphone, see Assigning Softphone on page 26.)

1. Find and select a contact. (For more information, see Managing Contacts on page 16.)
2. To make a voice call, do one of the following:
   • In the third pane, click 📞.
   • In the search results, double-click the contact.
   • From Favorites or Groups, double-click the contact.
3. To start broadcasting your video to the other party, click 🎥.
   A select layout button appears on the third pane, when a screen share and a video call are active at the same time. Click 🎥 drop-down to share with other members on the video call. (For more information on Screen sharing, see Sharing Screens with a Contact on page 67:
   • All
   • Data
   • Video
4. To end the video, click **Turn off Video Camera** icon.

**Setting Up Video Camera Preferences**

You can set up the Connect client to use the video camera:

• By default
• Prompt you to turn on the camera
• Wait for you to activate the camera manually, which lets you have complete control of your video camera.

To set up the video camera:

1. On the Dashboard, click the `<username>` tab.
2. On the second pane, click 🎥.
3. Click **Video > Permissions**.
4. Select one of the following video options:
   • **Automatically start my camera without asking**
   • **Ask me if I want to use my camera**
   • **Never ask me, I'll turn the camera ON myself**
5. Click **Video > Camera Setup**, and select the video device from the drop-down list. (You can view a preview from the selected video device.)

**Managing Voicemail**

Callers can leave a voicemail message if a call is not answered. The voicemail message is delivered to your assigned desk phone, the Connect client, and your email inbox. This section includes the following topics:

• Forwarding Calls to your Voicemail Inbox on page 40
MANAGING CALLS

- Leaving a Voicemail Message on page 40
- Accessing Voicemail Messages on page 41
- Viewing Voicemails from a Contact on page 41
- Listening to a Voicemail Message on page 41
- Saving a Voicemail Message on page 42
- Replying to a Voicemail Message on page 42
- Forwarding a Voicemail Message on page 42
- Deleting a Voicemail Message on page 43
- Restoring a Deleted Voicemail Message on page 43
- Configuring Email Notifications for Voicemail Messages on page 43
- Managing System Notifications for Voicemail Messages on page 43
- Changing your Voicemail Password on page 44

Note: To alert you about an incoming voicemail message you can set an email notification or a system notification. For more information, see the following

- Configuring Email Notifications for Voicemail Messages on page 43
- Managing System Notifications for Voicemail Messages on page 43

Voicemails and auto-attendant responses are transferred throughout the system using Simple Mail Transfer Protocol (SMTP). The default message size and session size limits on Information Services (IIS) 6.0 Manager are as follows:

- The maximum message size is 2048 KB.
- The maximum session size is 10240 KB.

Note:

- These limits are usually very low and should be modified to be over the size of the largest voicemail to avoid losing voicemails when voicemail boxes are moved between servers.
- Administrators must be careful when using the Bulk Edit tool to move multiple voicemail boxes at once. Mitel recommends moving fewer than 50 mailboxes at a time, even after adjusting the settings as described below.
- You can modify these limits on the headquarters (HQ) server or distributed voice server (DVS).

To view the default limits in Information Services (IIS) 6.0 Manager, follow these steps:

1. Open Internet Information Services (IIS) 6.0 Manager.
2. Expand the server, right-click SMTP Virtual Server, and select Properties.

   Figure 6 : IIS 6.0 Manager
3. In the window that opens, click the **Messages** tab to view the default limits on Information Services (IIS) 6.0 Manager.

**Figure 7 : Messages tab**
Note:

- Voicemails are stored at the following location: Shoreline Data/Vms/Message.
- The maximum size of voicemail messages for each user is directly related to the maximum message size set for the user’s Class of Service in HQ server.

**Forwarding Calls to your Voicemail Inbox**

When you receive an incoming call that you don’t want to answer, click in the notification area. The caller is directed to record a voice message.

After a caller leaves a voicemail message, you receive a badge notification on the Voicemail tab on the dashboard and on the Connect client icon on your computer task bar.

**Leaving a Voicemail Message**

1. Dial a contact. (For more information, see Making a Voice Call on page 29.)
2. When you are prompted to leave a voicemail message, record your message.

**Sending a Group Voicemail**

1. On the Dashboard, click the Contacts tab.
2. Click the Groups tab, and click on the group header to which you want to send a voicemail.
3. Click **Send Voicemail**.
4. To record the message through the desk phone, click .
To record the message through the computer speaker, click 🎧.

To start recording the message, click 🎧. To stop recording, click 🎧.

To play the recorded message, click 🎧.

6. Enter a title for your recording in the Subject field.

7. Specify any of the following options for the message:
   - **Urgent**—recipient can see an exclamation (!) mark next to the voicemail.
   - **Private**—recipient cannot forward a private voicemail.
   - **Receipt**—sends an acknowledgment to the sender when the recipient has listened to the voicemail.

8. Click Send.

**Accessing Voicemail Messages**

Each voicemail displays the following:

- Name and number of the voicemail sender.
- Date on which the voicemail was received. If you receive it on the current day, "Today" is displayed along with time and duration.
- Duration of the voicemail.
- Icons to indicate Saved (✔️), Private (🔒), and Urgent (❗️) voicemails.

To access a voicemail message:

1. On the Dashboard, click the Voicemails tab.

2. To access the voicemail messages for a specific category:
   - Click the All tab to view all (heard, unheard, and saved) the voicemail messages. The unheard voicemail messages are displayed in bold font, and preceded by a blue dot.
   - Click the Unheard tab to view the unheard voicemail messages along with the duration.
   - Click the Saved tab to view the saved voicemail messages that you have marked for easy retrieval.

   You can choose to reply, forward, save, or delete the received voicemails.

   To mark the message as heard or unheard, right-click the voicemail message and select Mark as Heard or Mark as Unheard.

   **Note:** You cannot mark the Workgroup voicemail messages as heard or unheard.

3. The Deleted Voicemails tab is displayed only if you have any deleted voicemail messages. To access the deleted voicemails, click on the Deleted Voicemails header. By default, the Deleted Voicemail tab is in collapsed view and displays the number of deleted voicemails on the header.

From the Voicemail tab, you can add the contact from whom you have received a voicemail message to your Favorites or Groups list. Right-click the contact's voicemail message, and select Add Contact to Group. From the drop-down list, select <group name> to which you want to add the contact.

**Viewing Voicemails from a Contact**

1. In the Quick Dialer Search field, enter the name or extension number and select the contact.
2. On the Contact card, click Voicemails.

All voicemails from a selected contact are displayed in the third pane. Click each voicemail entry to reply, forward or delete the voicemail.

**Listening to a Voicemail Message**

**Note:** When playing back a voicemail message through the PC audio device (speakers), the Connect Client does not support pause/resume and rewind/fast forward functions on the first playback of a message. This is because the client is streaming the message to the local computer. After the message is played for the first time, it is cached, and these functions are available.
1. On the Dashboard, click the **Voicemails** tab.
2. In the second pane, select the voicemail.
3. Click 🗡️ to play the message through desk phone or 🎤 to play through the computer speaker.
   
   **Note:**
   - The audio path for voicemails listened on computer speakers when Connect Client is in the soft phone mode does not change to desk phone after you select the desk phone mode. Because of this, voicemails continue to be played on the computer speakers even when Connect Client is in desk phone mode. Therefore, you must explicitly select Computer Speakers or Phone as the audio path to play the voicemails.
   - If a voicemail message is marked as private, the computer speaker and the deskphone speaker options are disabled. The private voicemail message can only be played through the deskphone.
4. Click 🎧 to play the voicemail message, and click 🎤 to pause the voicemail message. Use the progress indicator to skip forward or backward within the message.
   
   **Note:** If you have a desk phone and log into Connect Client, you will have soft phone and desk phone mode options. You have a choice to play voicemails either from desk phone or computer speakers in desk phone mode. If you have assigned your Connect client to Softphone, desk phone option will be displayed.

You can choose to reply, forward, or delete the received voicemail.

**Saving a Voicemail Message**

1. On the Dashboard, click the **Voicemails** tab.
2. On the second pane, click the **All** tab.
3. Right-click the voicemail you want to save, and select Save Voicemail. The save icon 📄 is displayed next to the voicemail name.

   To remove the voicemail from the Saved list, right-click the voicemail you want to remove, and select **Unsave Voicemail**.

**Replying to a Voicemail Message**

1. Access your voicemail messages as described in Accessing Voicemail Messages on page 41.
2. Click the voicemail that you want to reply to.
3. Click **Reply** and select any of the following icons:
   - 📡 to record the message through the telephone.
   - 🎤 to record the message through the computer microphone.
4. Click 🎧 to record your message.
5. Click 🎤 to stop recording.
6. Click 🎧 to play your recorded message.
7. Edit the **To** and **Subject** fields as required. While replying to a private voicemail message, you cannot add more members to the To field.
8. Specify any desired options (Urgent, Private, Receipt, and Include Original) for sending the response.
9. Click **Send** to send the voicemail, or **Cancel** to discard the recorded voicemail.

**Forwarding a Voicemail Message**

**Note:** You cannot forward private voicemail messages.

1. Access your voicemail messages as described in Accessing Voicemail Messages.
2. Click the voicemail message that you want to forward.
3. Click **Forward** and select any of the following icons:
MANAGING CALLS

• to record the message through the telephone.
• to record the message through the computer microphone.

4. Click 🎤 to record your message.
5. Click 🟥 to stop recording.
6. Click 🎧 to play your recorded message.
7. Edit the **To** and **Subject** fields as required.
8. Specify any desired options (Urgent, Private and Receipt) for sending the message.
9. Click **Send** to forward the voicemail, or **Cancel** to discard.

Deleting a Voicemail Message
1. Access your voicemail messages as described in Accessing Voicemail Messages on page 41.
2. Do one of the following:
   • Right-click the voicemail you want to delete, and select **Delete Voicemail**.
   • Select the voicemail you want to delete and click **Delete**.

Restoring a Deleted Voicemail Message
1. On the Dashboard, click the Voicemails tab.
2. Click ⬇️ on the **Deleted Voicemails** header to view the deleted voicemail messages.
3. Select the voicemail you want to restore.
4. Click **Restore** to restore a deleted voicemail.

Configuring Email Notifications for Voicemail Messages
1. On the Dashboard, click the <username> tab.
2. On the second pane, click 📦.
3. Click **Notifications** > Voicemail.
4. Select **Send email notification about incoming voicemail to <email address>**. Your email address configured on the Connect Director is displayed.
5. Do the following to customize the email notification:
   • To receive the voicemail as .wav file format, select the **Attach voicemail as a wave file** option.
   • To mark the voicemail as heard in your voicemail inbox, select the **Mark voicemail as heard** option.

Managing System Notifications for Voicemail Messages
1. On the Dashboard, click the <username> tab.
2. On the second pane, click 📦.
3. Click **Notifications** > Popup.
4. To get a system notification for an incoming voicemail:
   • For Windows, select the **Show a system notification for a voicemail** option.
   • For macOS:
     a. Under **Incoming Voicemail**, click **Configure via macOS Notification Center**.
     b. In the **Notification Center** box, click the **Connect Client** icon.
     c. Click any of the following:
        None
        Banners
        Alerts
Changing your Voicemail Password

1. On the Dashboard, click the <username> tab.
2. On the second pane, click 🔄.
3. Click Voicemail > Setup.
4. Enter:
   • Current password
   • New password
   • Confirm new password
5. Click Set New Password.

Recording Voicemail Greeting Name

1. On the Dashboard, click the <username> tab.
2. On the second pane, click 🔄.
3. Click Voicemail > Setup.
4. Click Record New Name.
5. Click 📡 to start recording your name, and click 🎧 to stop the recording.
6. Click 🎧 to listen to the recorded greeting.
7. Do one of the following:
   • To save the recording, click Save Recording.
   • To discard the recorded greeting, click Discard Recording, and repeat steps 4 to 7.

Setting Voicemail Escalation

You can set Voicemail Escalation notification for each new message or the first unheard message, by selecting the appropriate option. You can create 9 Voicemail Escalation Profiles.

To create a Voicemail Escalation Profile:

1. On the Dashboard, click the <username> tab.
2. On the second pane, click 🔄.
3. Click Voicemail > Escalation.
4. Select Add New Profile to create voicemail escalation profiles.
5. In the Profile Name field, enter a name.
   Note: In the Profile Name field a default name appears. However, you can modify or update the field.
6. Set notification alert frequency using Repeat Times field.
7. In the Add Step section, do either of the following to enable the escalation routing notifications for all or urgent only voicemail:
   • Select Send email notification check box to set email notifications and enter the email address in the field, for text only notifications.
   • Select Attach Wave File check box to include a .wav file.
   • Select Send phone notifications check box to set phone notifications, and enter the phone number in the field.
   • Set the timeout period to end the notification.

To add additional steps, click Add Step.

To remove any additional step, click 📡 next to the step.

Note: After a voicemail is marked as Heard the escalation process will stop. If a user sets the voicemail back to Unheard, the escalation process will continue to run until the voicemail again goes back to the unheard state.

Assign Voicemail Escalation Profile to Availability State

1. On the Dashboard, click the <username> tab.
2. On the second pane, click.
3. Click Call Routing > Availability Routing.
4. In the When field, click the drop-down list, and select one of the availability states.
5. In the Voicemail Escalation Profile field, click the drop-down list, and select the required profile.

Note: You can assign a Voicemail Escalation Profile for your availability state except for Do Not Disturb state.

Editing a Voicemail Escalation Profile
You can edit a Voicemail Escalation Profile:

1. On the Dashboard, click the <username> tab.
2. On the second pane, click.
3. Click Voicemail > Escalation.
4. Select the profile from the main list, click Edit.
5. Update the information and click Update to confirm the changes.

Deleting a Voicemail Escalation Profile
You can delete a Voicemail Escalation Profile to cancel the escalation route:

1. On the Dashboard, click the <username> tab.
2. On the second pane, click.
3. Click Voicemail > Escalation.
4. Select the profile from the main list, click Delete.
5. In the confirmation dialog box, click Delete to delete the Voicemail Escalation Profile.

Playing Envelope Information for Voicemail

1. On the Dashboard, click the <username> tab.
2. On the second pane, click.
3. Click Voicemail > Playback.
4. Select Play envelope information when listening to messages to hear the received date and time of the voicemail.
   Note: The system will announce the date and time when the voicemail was received in the user's inbox before playing the message.

Routing Calls
Use the following methods to route incoming calls to your predefined external phones:

- Availability Routing—to assign call routing rules based on availability states
- Power Routing—to set customized rules

Availability Routing
Availability Routing allows you to route incoming calls according to your availability state. You can configure Availability Routing with or without Mobility.

Configure Availability Routing with Mobility

1. On the Dashboard, click the <username> tab.
2. On the second pane, click.
3. Click Call Routing > Availability Routing.
4. In the When field, click the drop-down list, and select one of the availability states.
   Note: By default, incoming calls are routed to your extension and to your Mobility device.
5. Click the Start Wizard on the right.
6. To specify your Connect Mobility enabled device, do one of the following:
   • In the Blank field, type your 10-digit mobile number.
• If you do not have a mobility device, then click My device with Mitel Mobility will not have a number associated with it.

7. Click Next. The Simultaneous Ring page is displayed.
   Note: By default, the Simultaneous Ring page displays an extension and a mobility device that are already included for simultaneous ring.

8. To enable an additional device, other than your extension and a mobility device, to ring simultaneously:
   a. Enable the Also simultaneously ring these numbers option.
   b. Click the Select Number drop-down list.
   c. Select the appropriate option, and click Use Selected Number.

9. Click Next.

10. To configure call forwarding, select one of the following options:
    Note: If you are not available on any of the devices configured for simultaneous ringing, then you can route the incoming calls either to your voicemail or to any other external number with appropriate permissions.
    • Select Keep ringing the numbers above.
    • Incoming calls will not be forwarded, and only the devices dedicated for simultaneous ringing are permitted to ring.

11. To forward incoming calls to your voicemail or to another contact, do the following:
    a. Select Forward the call to, and click on the drop-down list, and either select my voicemail or type in the contact name or the external number, if you have appropriate permissions.
    b. Click the drop-down list to select the number of rings before forwarding.
    c. In the If I have more than 16 active calls forward immediately to field, click the drop-down list, and either select my voicemail, or type the contact name or the external number, if you have appropriate permissions.

12. Select Always forward my calls to, and click the drop-down list, and either select my voicemail or type the contact name or the external number, if you have appropriate permissions.

13. Click Next. The Voicemail Greeting: Recording & Playback page opens.

14. To record the voicemail greeting:
    a. Click to start recording your message, and click to stop the recording.
    b. Click to listen to the recorded greeting for any incoming voicemail messages.
    c. Do one of the following:
       A. To save the recorded greeting, click Save Recording.
       B. To discard the recorded greeting, click Discard Recording.

15. Click Next. The Interacting with Greeting page is displayed.

16. To enable interaction with the voicemail greeting:
    a. Under Are callers allowed to leave a voicemail after hearing your greeting?, select one of the following options:
       • Yes, callers can leave a voicemail.
       • No, callers will not be able to leave a voicemail.
    b. If you want to forward the incoming call to a particular extension, in the If callers press '0' while listening to your greeting Forward calls to field, type a contact name or an extension.

17. Click Done.

Configuring Availability Routing without Mobility

1. On the Dashboard, click the <username> tab.

2. On the second pane, click.

3. Click Call Routing > Availability Routing.

4. Click the Start Wizard. The Simultaneous Ring page opens.
   Note: By default, the Simultaneous Ring page displays the device that is already configured for simultaneous ring.

5. To enable simultaneous ring for an additional device, do the following:
   a. Select Also simultaneously ring these numbers.
b. Click the **Select Number** drop-down list.

6. **Click Next.**

7. **To configure call forwarding, select one of the following options:**
   
   • If you do not want to forward incoming calls, select **Keep ringing the number above so that the devices dedicated for simultaneous ringing are only permitted to ring.**
   
   • If you want to forward incoming calls to your voicemail, do the following:
     
     a. Select **Forward the call to** and click on the down arrow icon, and select **My voicemail.**
     
     b. Click the drop-down list to select a number for the rings before forwarding.
     
     c. In the **If I have more than X active calls forward immediately to** field, click the down arrow icon, and select **My voicemail.**

6. **Click Next.**

8. **To enable FindMe, do the following:**

   **Note:**
   
   If the **FindMe option is not displayed, contact your Administrator to enable the Allow external call forwarding and find me destination option in Connect Director.**

   a. Select **Enabled: Use my FindMe settings to continue routing the call.**
   
   b. Select any one of the following options:
     
     • **Select Ring my FindMe numbers sequentially before playing my voicemail,** and optionally select **Prompt the caller to record their name.**
     
     • **Select Play my voicemail first. If the caller presses 1 during the greeting then sequentially ring my FindMe numbers, and check Prompt the caller to record their name.**
     
     c. To define FindMe numbers that will be used sequentially, click the **Select Number** drop-down list, select the appropriate option and click **Use Selected Number.**
     
     d. To add another FindMe number, repeat the previous step.

9. **To enable voicemail greeting, see To record the voicemail greeting:**

10. **Click Next.** The **Voicemail Greeting: Recording & Playback** page opens.

11. **To enable voicemail greeting, see To record the voicemail greeting:**

12. **Click Next.** The **Interacting with Greeting** page opens.

13. **To enable interacting with the voicemail greeting, see To enable interaction with the voicemail greeting:**

---

**Configuring Availability Routing Using Custom Settings**

1. On the Dashboard, click the `<username>` tab.

2. On the second pane, click **.**

3. **Click Call Routing > Availability Routing.**

4. **To configure a mobility device for incoming calls, see To specify your Connect Mobility enabled device, do one of the following:**

5. **Click Change/Record to configure the following options, as required:**

   • **Incoming calls are routed to your Deskphone.**
     
     • **No phones selected to simultaneously ring.** To configure this option:
       
       - **For simultaneous ring with mobility enabled, see To enable an additional device, other than your extension and a mobility device, to ring simultaneously:**
       
       - **For simultaneous ring without mobility enabled, see To enable simultaneous ring for an additional device, do the following:**

   • **Number of rings before incoming calls are routed to voicemail.** To configure this option:
     
     - **For incoming call forwarding with mobility enabled, see To configure call forwarding, select one of the following options:**
     
     - **For incoming call forwarding without mobility enabled, see To configure call forwarding, select one of the following options:**

   • **To configure the If callers press 1 while listening to my voicemail greeting, no phones are selected to sequentially ring option, see To enable FindMe, do the following:**

   • **No voicemail greeting recorded.** To configure this option, see **To record the voicemail greeting:**

---

47
• Callers are allowed to leave a voicemail. To configure this option, see To enable interaction with the voicemail greeting:
• Callers who press 0 during the voicemail greeting will be forwarded to the Auto-Attendant. To configure this option, see To enable interaction with the voicemail greeting:

Using Power Routing
Power Routing allows you to create customized personal rules for call routing. You can also edit and delete your power routing rules.

Power Routing overrides Availability Routing.

Creating a Power Routing Rule
1. On the Dashboard, click the <username> tab.
2. On the second pane, click ⚙.
3. Click Call Routing > Power Routing.
4. Click Create New Power Rule.
5. In the Rule Name field, enter a <name> for the new power rule.
6. In the When field, choose a combination of the following conditions to build a custom file for when to forward a call:
   • + number matches
   • + dialed number
   • + my availability
   • + on the phone
   • + time is
7. To add a rule by matching a number:
   a. Click + number matches.
   b. Click the The number is drop-down list, and select a suitable option. (For a few of these options, you might have to enter an associated number in the corresponding field.)
   c. To create another rule, repeat the previous two steps.
8. To add a rule based on the known dialed number:
   • Click + dialed number.
   • Click inside the Number caller dialed to reach me is field, and enter the known number.
9. To add a rule based on your availability:
   a. Click + my availability.
   b. Select one of the availability states:
      • Available
      • In a Meeting
      • Out of Office
      • Vacation
      • Custom
      • DND
10. To add a rule if you are already on a phone, click + on the phone.
11. To add a rule based on the time or on the day:
   a. Click + time is.
   b. Select either of the following:
      • If Time is selected, enter the From and To fields for the power rule.
      • If Day is selected, select the days for the power rule.
12. Under Then, click Forward call to and select any of the following options:
   • To forward the call to voicemail, select the My Voicemail option.
   • To play a ring tone:
     - In the My Voicemail drop-down list, select Play Ringtone. An additional Standard Ring option is displayed.
- Click on the drop-down list and select a ring tone option.
- To forward the call to specific number, in the Select Number field enter the desired number.

13. Click Create Rule.

Modifying a Power Routing Rule

1. On the Dashboard, click the <username> tab.
2. On the second pane, click .
3. Click Call Routing > Power Routing.
4. For the power rule you want to edit, click Edit.
5. Edit the steps as required. (For more information, see steps 6 to 12 in the Creating a Power Routing Rule on page 48 section.)
6. Click Save Rule.

Deleting a Power Routing Rule

1. On the Dashboard, click the <username> tab.
2. On the second pane, click .
3. Click Call Routing > Power Routing.
4. Click Delete for the power rule you want to delete.

Routing Calls to Mobile

You can route all your incoming calls to your Mobility device. You can select or enter the mobile number on which you have installed the Connect Mobility.

To enable this feature, your Connect administrator must configure the Enable Enhanced Mobility with Extension feature in the Connect Director.

Customizing your Call Option Settings

1. On the dashboard, click the <username> tab.
2. On the second pane, click .
3. Click Telephony.
4. In the Maximum number of concurrent calls drop-down list, and select a number in the range configured by your Connect administrator.
5. To suppress call waiting tone, select Suppress call waiting tone when I’m on a call.
6. To suppress dial tone, select Suppress dial tone when I’m off-hook in headset mode on an analog phone.
7. To close contact card soon after you end the call, select Close contact card after call ends option.
Managing Messages

This chapter provides information about managing messages.

- Viewing Direct Conversation History with a Contact
- Scheduling a Meeting with a Contact Group
- Managing Message Notifications

Viewing Direct Conversation History with a Contact

- For MiVoice Connect Users:
  1. In the Quick Dialer Search field, enter the contact name or extension number and select the contact.
  2. In the third pane, click Messages.

Your message conversation history with the contact is displayed in the third pane. Optionally, you can also search for a particular conversation by using a keyword in the Quick Dialer Search field.

Scheduling a Meeting with a Contact Group

1. On the Dashboard, click the Contacts tab.
2. Click the Groups tab, and select a group.
3. Click on the group header and click Schedule Meeting.
4. Specify the details of the meeting.
5. Click Create.

Managing Message Notifications

To receive a system notification for message:

1. On the dashboard, click the <username> tab.
2. On the second pane, click Notifications > Popup.
3. Click Notifications > Popup.
4. To enable messaging notification:
   - On Windows, select Show a system notification for an incoming IM option.
     - Select Show IM content in the notification option to see the message in the system notification.
     - Select Keep notification on screen for option, and click the drop-down list and select a number from the list to control the persistence of the notification on your system.
   - On macOS:
     a. Click Configure via macOS Notification Center... in Incoming IM.
     b. In the Notification Center section, scroll down to select the Connect client icon and then click any of the following options:
        - None
        - Banners
        - Alerts

Note: The Incoming IM option does not appear on both Windows and Mac system.
5. To disable messaging notification:
   - On Windows, disable the Show a system notification for an incoming IM option.
   - On macOS:
     a. Click Configure via manOS Notification Center.
     b. Select Do Not Disturb on the left notification area.
Adding Canned Message Responses

Canned IM response allows you to respond to an incoming call with an IM message that is predefined in the Connect Client application. If you are unable to respond to an incoming call in person, you can send a Canned IM response to the contact.

To add a canned IM response:

1. On the Dashboard, click the <username> tab.
2. On the second pane, click .
3. Click IM > Canned IM Responses.
4. Enter your custom canned message, and click Add Canned Response.
5. Select the required canned messages from the text box, and click Delete to delete the canned message.
Integrating with Microsoft Exchange

This chapter provides information about integrating the Connect client with Microsoft Exchange:

• Integrating the Connect client with Microsoft Exchange

Integrating the Connect client with Microsoft Exchange

You must integrate the Connect client with your Microsoft Exchange to use the following client features:

• Synchronize events and availability status with the Outlook or Office 365 calendar.
• Synchronize your Outlook or Office 365 contact folders with the Connect client for Windows. For macOS, the Connect client synchronizes with the Mac Address book. (For more information about synchronizing the Connect client with Mac address book, see Importing the Contact Folders on page 18
• Send voicemail notifications to Outlook or Office 365.

To integrate Microsoft Exchange with the Connect client:

1. On the Dashboard, click the <username> tab.
2. On the second pane, click .
3. Click Account > AD Credentials.
   The AD credentials tab does not appear if you have integrated the Connect client with Microsoft Exchange while logging in. For more details about signing in to the Connect client, see Signing in to the Connect Client on page 10.
4. In the User name and Password fields, enter your Microsoft Exchange (Active Directory) email address and password respectively.
5. Click Save Credentials.

If your Exchange server is not configured on the Connect Director, the error message Your Exchange Server is not set up. Please contact your Connect Administrator is displayed.

Upon successful credentials validation, the Unlink Mitel Connect from Exchange option is displayed.

To disable integration with Microsoft Exchange, click this option. You must restart the Connect client for the changes to take effect.

Note: If you do not complete the integration with Microsoft Exchange here, the Connect client will prompt you to enter your Microsoft Exchange credentials when you access the Events tab.

Synchronizing Events with Microsoft Outlook or Office 365 Calendar

If you have not integrated the Connect client with Microsoft Exchange, you can integrate it from the Events tab.

To integrate the Connect client with Microsoft Exchange from the Events tab:

1. On the Dashboard, click the Events tab.
2. Enter your Microsoft Exchange credentials in the User name and Password fields.
3. Click Submit Exchange Credentials.

After integrating the Connect client with Microsoft Exchange:

• Your Outlook appointments and Connect client events are displayed on both the Outlook calendar and the Events tab.
• When you create an event on Connect client, a meeting invite with the conference details is displayed in Outlook which can be sent to the participants. For more information about creating an event on Connect client, see Creating a Conference on page 55.

Note: When you install the Connect Add-in Outlook plugin, enabling a delegate to access your Outlook calendar allows the delegate to perform the following options on your calendar:

• Create new Connect conferences
• Edit existing Connect conferences only if the delegate is added as an organizer of the conference.
INTEGRATING WITH MICROSOFT EXCHANGE

- Delete Connect conferences

This option is available only on Windows.

You can synchronize the availability state between the Connect client and the Outlook or Office 365 calendar. For example, if you have a meeting currently scheduled on Outlook calendar, your availability state on Connect client changes to “In a meeting”. However, you can also manually change your availability state on the Connect client.

To synchronize your availability state on the Connect client with the Outlook or Office 365 calendar:

1. On the dashboard, click the <username> tab.
2. On the second pane, click 🔄.
3. For macOS, click Contacts/Outlook. For Windows, click Outlook.
   Note: For Windows, the “ConnectUCBAddIn” add-in should be enabled on your Outlook to complete this synchronization. For more information about enabling Add-ins in Outlook, see Microsoft Outlook documentation.
4. Select the Sync my Exchange calendar with my Mitel Connect availability modes check box.
   • Your availability state on the Connect client changes based on your schedule on the Outlook or Office 365 calendar.
   • The Do Not Disturb, the Vacation, and the Custom availability states always take precedence and do not get affected by this setting.
5. Select the Use my Outlook Work Hours to switch my Mitel Connect availability to Out of Office option to change your availability state to Out of Office based on your work hours and days specified on your Microsoft Outlook or Office 365 calendar.

You must restart the Connect client for any changes to take effect.

For information about setting the work hours and days on Outlook calendar, see the Microsoft Outlook documentation.

Synchronizing the Connect client with Microsoft Outlook or Office 365 Contact Folders

After integrating the Connect client with the Microsoft Exchange, you can import the contact folders from Microsoft Outlook into Connect client to make calls or send messages only for Windows.

To import the contact folders from Microsoft Outlook or Office 365 into Connect client (this is applicable only for Windows):

Note: The “ConnectContactUploadAddIn” add-in should be enabled on your Outlook to import the contact folders. For more information about enabling Add-ins in Outlook, refer to Microsoft Outlook documentation.

1. On the dashboard, click the <username> tab.
2. On the second pane, click 🔄 and then click Outlook.
3. Select the Sync my Outlook contacts option.
4. Click +Show contact folders and select the folders that you want to synchronize with the Connect client.

You can also import the Outlook contact folders shared by other users into your Connect client. For the shared contact folders to appear in +Show contact folders, open the shared invitation email and click Open this Contacts folder. For more details about sharing a contact folder in Outlook, see Microsoft Outlook documentation.

For macOS, you can synchronize the Connect client with the Mac address book. For information about synchronizing the Connect client with Mac address book, see Importing the Contact Folders on page 18.

You can search for contacts from your Microsoft Outlook Public folders, but you cannot import contacts from Public folders to Connect client.

To enable searching for the contact from the Exchange Public Contact folders:

1. On the Dashboard, click the <username> tab.
2. On the second pane, click 🔄.
3. For macOS, click Contacts/Outlook. For Windows, click Outlook.
4. Select the Enable searching for contacts in my exchange public contact folders check box. You can view the contacts from your Exchange Public folders in the Connect client directory.

Synchronizing the Connect client Voicemails with Microsoft Outlook or Office 365

After integrating the Connect client with Microsoft Exchange, you can synchronize the Connect client voicemails with Microsoft Outlook or Office 365 only for Windows.

Note: The “ConnectSTVMAddin” add-in should be enabled on your Outlook to complete this synchronization. For more details about enabling Add-ins in Outlook, see the Microsoft Outlook documentation.

1. On the Dashboard, click the <username> tab.
2. On the second pane, click 
3. Click Voicemail > Outlook.
4. Select the Show my voicemails inline in my Outlook inbox option.

Understanding the Presence Status in Microsoft Outlook

Microsoft Outlook displays the presence status of a contact beside the contact’s name. For Mitel system users, the presence status indicates the availability status of a contact as configured by the user. (See Understanding Availability States on page 22.)

If Outlook is not synchronized, incorrect or no presence status information might be shown.

For any issues related to Outlook synchronization, contact your system administrator and ensure that in Mitel Connect Director or BOSS:

• The Outlook email address and the Mitel system email address are the same.
• The IM functionality is enabled for the user.
Managing Conferences

This chapter provides information about how to create and manage Connect conferences.

- Creating a Conference
- Editing a Conference
- Viewing Conferences
- Downloading the iCalendar Data (ICS) File for a Conference
- Joining a Conference
- Placing a Participant on Mute
- Dropping a Participant from Conference
- Recording a Conference
- Canceling a Conference
- Conferencing using Connect client for Web

Creating a Conference

1. On the Dashboard, click the Events tab.
2. Click icon at the top right corner of the second pane.
3. In the Name field, enter a name for the conference. This name is used in email notifications about the conference.
4. In the Start fields, enter the date, and the start time of the conference.
5. In the Meeting Lasts field, enter the duration of the meeting in hours and minutes.
6. From the Occurs drop-down list, select the recurring frequency of the conference.
   **Note:** You will see the Occurs field only if you have not integrated the Connect client with Microsoft Exchange.
7. In the On Site Location field, enter the venue for the conference.
   Alternatively, check the Use my own bridge option to use the reservation-less conference bridge. Select the conference bridge of your choice from the drop-down list. For more information, click next to Use my own bridge option.
   **Note:** You will see the Use my own bridge option only if you have reservation-less conference and integrated the Connect client with Microsoft Exchange.
8. In the Organizers field, enter the names of the people hosting the conference.
9. In the Presenters field, enter the names of people presenting during the conference.
   Check the option below the Presenters field, to add additional participants, external contacts who require approval from the meeting organizer to share their screen.
   **Note:** You can drag and drop contacts to shift them between the Organizers, Presenters, and Participants fields.

10. In the Agenda field, enter the name of the agenda and the duration of the agenda in minutes.
11. In the Overview field, enter a brief description of the purpose of the conference.
12. To attach any reference material for the participants, click Choose from Dropbox in the Files section. To attach files, you must sign in to Dropbox with your credentials.
   **Note:** If the Choose from Dropbox tab is disabled for on-site users, you cannot add new files from the Dropbox.

   To enable the Choose from Dropbox feature, contact the system administrator.

13. In the More Settings section:
   a. To set a customized access code, user can select Custom Access Code option.
   b. To set a password, select the Protect Meeting with Password option, and enter the password in the Password field.
   **Note:**
The Participant Code and the Organizer Code are automatically generated. Optionally, you can set the Participant and Organizer Code using settings in the D2 UCB.

c. In the **Start the Meeting** section, choose one of the following options:

- When anyone joins
- When one of the organizers joins

d. In the **Participants** section:

- To announce the arrival of a participant on the conference call, select the Announce when participants arrive option, and select one of the following options:
  
  **Play a simple audio tone**
  
  Prompt participants to record their name, and announce when they try to join and leave the meeting
  
  - To mute all participants joining the conference call, select the Mute participants on entry option.
  - To display the names of all participants who have joined the conference, select the **Show everyone’s name to all participants** option.
  - In the When dialing out to participants area, select one of the following options:

  **Must press one to enter audio portion of the meeting**

  Participants are automatically added to the audio portion of the meeting

14. Click **Create** to generate the invite.

15. Depending on your configuration, you see one of the following results:

- If the Connect client is successfully integrated with Microsoft Exchange, you see a Create Conference Success Opening Outlook Please Wait message. An email invite draft is opened in Microsoft Outlook, where you can review the content, set reminders and recurrence, and review the list of participants before sending the invite. If you do not see this invite, see [Integrating the Connect client with Microsoft Exchange](#) on page 52 for information about integration.

- If you have not integrated the Connect client with Microsoft Exchange, the new event is created and displayed with the Connect assigned details as described in the table **Connect Conference Details**. When you click Events on the dashboard, the conference is listed on the Upcoming tab in the second pane.

### Table 4: Connect Conference Details

<table>
<thead>
<tr>
<th>Conference Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The meeting ID that is automatically generated by the Connect system when an event is created</td>
</tr>
<tr>
<td>Dial-in Info</td>
<td>The conference call dial-in info for host and participants</td>
</tr>
<tr>
<td>&lt;Web Conference link for leader/host&gt;</td>
<td>Connect Conference web page link for the host</td>
</tr>
<tr>
<td>Participant Code</td>
<td>The access code for participants to join the conference call</td>
</tr>
<tr>
<td>&lt;Web Conference link for participants&gt;</td>
<td>Connect Conference web page link for participants</td>
</tr>
<tr>
<td>Password (optional)</td>
<td>The password to join the secure conference call</td>
</tr>
<tr>
<td>Additional Calling Info</td>
<td>The dial-in info for different regions. This information is fetched from the Connect Director. To update this information, contact your Connect administrator.</td>
</tr>
</tbody>
</table>

### Editing a Conference

As an organizer, you can edit a conference. To edit a conference, do the following:

1. On the Dashboard, click the **Events** tab.
2. Click the **Upcoming** tab to view all the upcoming conferences.
3. Select the conference.
4. Click.
5. Edit the conference details in the required fields, and click Save.

Creating a Conference from Microsoft Outlook

1. Launch Microsoft Outlook.
2. Click New Items > Meeting.
3. Click the conference icon at the top right corner of the Outlook ribbon.

   A Connect conference is automatically generated with the details listed in Connect Conference Details appended to the email invite.

4. In the To field, enter the list of participants to invite to the conference. Click Address Book or Check Names to select or identify directory contacts.
5. To assign participant’s role:
   a. Click Conference > Settings to open the conference settings window.
   b. Un-check Collaborative meeting - everyone can present field.
   c. Click the drop-down next to the presenter’s name and select the required role.
   d. Click OK to save.
6. In the Subject field, enter the purpose of the conference.
7. In the Location field, enter the venue of the conference.
8. In the Start time fields, enter the date and start time of the conference.
9. In the End time fields, enter the date and end time of the conference.
10. Click Response Options to configure the responses received from the participants.
11. Select the time slot from the Reminder drop-down list to set a reminder.
12. Click Recurrence if you want the conference to occur more than once.
13. Click the Available Outlook option to configure any other preferences.
14. Click Send.

Creating a Reservation-less Conference

You must have Outlook configured with the Connect client before creating a reservation-less conference. The event invite can be shared only using Outlook.

You can start a conference directly from the second pane on the Connect client without scheduling the conference in advance. This is called a reservation-less conference. You can also invite other users to join these conferences.

To invite participants to a conference:

1. On the Dashboard, click the <username> tab.
2. Click the arrow next to the conference bridge name and do one of the following:
   • To dial into the conference, click.
   • To share the screen or send an IM without joining the conference, click. You can also dial into the conference or configure a call back from here.
   • Open the Link provided in the conference bridge in a web browser.
   • See Additional Calling Info to use the region specific toll free dial in info.
3. To invite participants to join your conference, do one of the following:
   • Click Copy to copy the conference information, and share the information with other users you want to invite.
   • After launching the conference, click and type the participant’s name you want to invite and then click Conference.
4. To drop a participant, on the dashboard:
   a. Click icon below the participant name.
   b. In the confirmation dialog box, click Yes.
Adding a new Reservation-less Conference

You can use the My Conference section to add a reservation-less conference. To add a new conference bridge:

1. On the second pane, click Add New Conference Bridge.
2. In the Add New Conference Bridge pop-up window:
   - Enter the name of the conference in the Name field.
     
     **Note**: The Participant Code and the Organizer Code are automatically generated. Optionally, you can set the Participant and Organizer Code using settings in the D2 UCB.
3. In the More Settings section:
   - Set a password for the conference, by enabling the Protect Meeting with Password option, and entering a password
   - In the Start the Meeting section, choose one of the following options:
     - When anyone joins
     - When one of the organizers joins
   - In the Participants section:
     - To announce the arrival of a participant on the conference call, select the Announce when participants arrive option, and select one of the following options:

     - Play a simple audio tone
     - Prompt participants to record their name and announce when they try to join and leave the meeting
     - To mute all participants joining the conference call, select the Mute Participants on entry option.
     - To display the names of all participants who have joined the conference, select the Show everyone's name to all participants option.
   - In the When dialing out to participants section, select one of the following options:
     - Must press one to enter audio portion of the meeting
     - Participants are automatically added to the audio portion of the meeting
4. Click Add.

Editing a Reservation-less Conference

From the Edit, a user can remove or update a reservation-less conference bridge. Click Remove to delete a conference bridge.

To update a reservation-less conference bridge:

1. On the second pane, click the drop down next to the selected conference bridge name and click Edit.
2. Edit the name of the conference bridge in the Name field, and you can do the following in the More Settings section:
   - Set a password for the conference, by enabling the Protect Meeting with Password option, and entering a password.
   - Select the required options from Participants section and the When dialing out to participants section respectively.
3. Click Update to save the changes.

Migrating Reservation-less Conferences from ST Communicator

Reservation-less conferences migrate from ST Communicator to the Connect client as follows:

- Users who have a reservation-less conference that was previously configured in ST Communicator and who are unassigned to a service appliance will get an error message when trying to create a new event or if they try to join to an existing conference in the Connect client. To remove these conferences from the Connect client, users should manually delete the old conferences from Outlook Calendar.
- Users who have a reservation-less conference that was previously configured in ST Communicator and who are assigned to a service appliance will have a reservation-less conference created during migration, and the settings defined previously remain valid.
While participant codes on a migrated reservation-less conference remain valid, the When dialing out to participants parameter in the event screen is always set to Must press one to enter audio portion of the meeting regardless of whether the conference was previously configured with Participants are automatically added to the audio portion of the meeting.

**Note:**
- If users have multiple reservation-less conferences configured in ST Communicator, all the reservation-less conferences are migrated.
- Reservation-less conferences can be edited or changed after migration.

- Users who do not have a reservation-less conference previously configured in ST Communicator and who are not assigned to a service appliance will not have a reservation-less conference created during migration.

**Accessing Recordings Made with ST Communicator**

Prior to migrating from ST Communicator to the Connect client, download any recordings made with ST Communicator and save them to your local system. While the downloaded recordings cannot be played in the Connect client, you can use a Flash player to play them.

**Viewing Conferences**

1. On the Dashboard, click the **Events** tab.
2. Click **Upcoming** to view the list of future conference, and click **Past** to the list of conference in the past.

The list is sorted by date, from the most recent to the oldest.

You can filter past events to display only the Recorded events. To filter, click \(\text{-filter}\) in the **Past** tab and select **Recorded Only**.

To view the events of a specific date, click \(\text{select date}\) on the second pane and select the date. The events for the selected date will display at the top of the second pane.

**Note:** If you have integrated the Connect client with Microsoft Exchange, you see all your conferences in your Outlook calendar.

**Downloading the iCalendar Data (ICS) File for a Conference**

The Connect client generates an ICS file for every event. The Connect client uses the generated ICS file to send a meeting invite if Microsoft Exchange is not deployed. All participants can use this ICS file to populate their calendars with the meeting invite.

To download the Conference iCalendar data file:

1. On the Dashboard, click the **Events** tab.
2. Click the **Upcoming** tab to view all upcoming conferences.
3. Select the conference in the second pane to download the ICS file.
4. Click \(\text{save}\).

   The **Save As** dialog box is displayed. The default file name is `mitel.ics`, and the default path for saving the file is `C:\Users\<user>\AppData\Local\mitel\Meetings`.
5. Enter the file name and select the location or accept the default, and click **Save**.
6. Locate the file on your computer, and double-click to open the iCalendar file.
7. Review all the information about the conference, and save to your calendar.

**Joining a Conference**

You can join a conference from the Connect client in the following ways:

- **Joining a Conference from the Dashboard**: Use this procedure if you see a notification for the upcoming conference in the notification area on the dashboard. The notification is usually sent 5 minutes prior to a conference.
• Joining a Conference from the Events Tab: Use this procedure to join the conference from the Events tab.
• Joining a Conference from Your Calendar: Use this procedure to join the conference from your calendar.
• Joining a Conference from iOS device: Use this procedure to join the conference from your iOS device.

Following figure describes the different ways to join a conference.

**Figure 8 : Joining a Conference**

### Joining a Conference from the Dashboard

When you see an event notification on the dashboard, do one of the following to join:

- **To configure a call back:**
  1. Click the drop-down icon in beside the event name.
  2. In the **Call me at** field, enter your phone number. Optionally, you can skip this step if you have configured a call back in the previous conference and you want to use the same number (the previous number is saved in the **Call Me** field).
  3. Click **Call Me**

- **To dial into the conference,** click the call icon in beside the event name.
  - If you have assigned a softphone to the Connect client, you see a notification on the dashboard when you are connected.
  - If you have assigned a desk phone or an external number to the Connect client, the assigned phone rings.

  If you are unable to dial into the conference through the assigned phone, see Managing your Desk Phone on page 26.

- **To share the screen or send an IM without joining the conference,** click . You can also dial into the conference or configure a call back from here.
If you have joined the screen share, click on the task bar at the bottom of the second pane and do one of the following to dial into the conference:

- To join the conference through the assigned phone (softphone or desk phone), click Call via <assigned phone>. If you have assigned any external number, click Call External Assignment.
- To configure a call back, in the Call me at field enter your phone number, and click Call Me.

To end the conference, click .

Joining a Conference from the Events Tab
1. On the Dashboard, click the Events tab.
2. To view all upcoming conferences, click the Upcoming tab.
3. Select the conference that you want to join and do one of the following:
   - To configure a call back:
     a. Click the drop-down icon beside the event name.
     b. In the Call me at field, enter your phone number. Optionally, you can skip this step if you have configured a call back in the previous conference and you want to use the same number (the previous number is saved in the Call Me field).
     c. Click Call Me.
   - To dial into the conference, click beside the event name.

   - If you have assigned a softphone to the Connect client, you see a notification on the dashboard when you are connected.
   - If you have assigned a desk phone or an external number to the Connect client, the assigned phone rings.

   If you are unable to dial into the conference through the assigned phone, see Managing your Desk Phone on page 26.
   - To share the screen or send an IM without joining the conference, click . You can also dial into the conference or configure a call back from here.

If you have joined the screen share, click on the task bar at the bottom of the second pane and do one of the following to dial into the conference:

- To join the conference through the assigned phone (softphone or desk phone), click Call via <assigned phone>. If you have assigned any external number, click Call External Assignment.
- To configure a call back, in the Call me at field enter your phone number, and click Call Me.

To end the conference, click .

Joining a Conference from Your Calendar
If you have successfully integrated the Connect client with Microsoft Exchange or have downloaded and added the iCalendar data file to your personal calendar, you can join a conference by opening the appointment on your calendar.
1. Open your calendar.
2. Open the conference invitation.
   The invitation contains the details of the conference, as described in Connect Conference Details.
3. Do one of the following:
   - Click the Click Here to Join link.
   - Open the URL provided in the conference invitation on a web browser.
4. In the Introduce yourself as field, enter your name and press Enter.
5. Click on the task bar at the bottom of the page, and do one of the following:
• To join the conference through the computer audio, click **Call via Computer Audio**.
• To configure a call back, in the **Call me at** field enter your phone number, and click **Call Me**.

  **Note:**
  - You can configure a call back only after the organizer joins the conference. If the organizer has not joined the conference, the **Call Me** option is disabled, and you see the message, **Available after an organizer joins** below the **Call Me** field.
  - **Call via Computer Audio** is not supported in the Safari 12.0 browser.

6. You can perform the following actions during the conference using the icons on the task bar at the bottom of the page:
   • To leave the call during the conference, click 📞.
   • To mute and unmute your audio during the call, click 🎤.
   • To share your screen, a portion of the screen, or an application window, click 🎨.
   • To view and copy the meeting information, click 📁.
   • To ask a question during the conference, click 📚.

7. After the conference ends, close the browser to leave the conference.

Optionally, you can use the dial-in info and the participant code given in the conference invitation to join the conference through your cell phone.

**Joining a Conference from iOS device**

To join a web conference from an iOS device, do either of the following:

• If the Mitel Connect application is installed on your iOS device, all the Outlook meetings are displayed.
  1. Open Mitel Connect.
  2. Open the Conference invitation to display details of the conference.
  3. Select either **Join Audio** to join the audio bridge or **Join Web Bridge** to open the conference in a web browser.
  4. In the **Introduce yourself as** field, enter your name.
  5. In the **Call me at** (optional) field, enter your number.
  6. Click **Join** to join the conference.

• If the Mitel Connect application is not installed on your iOS device.
  1. Do one of the following on your iOS device:
    - Open your calendar and select the meeting URL you want to join. The web portion of the conference opens in the Connect web collaboration client launched through the Safari browser.
    - Open the Safari browser and enter the meeting URL. The web portion of the conference opens in the Connect web collaboration client launched through the browser.
  2. In the **Introduce yourself as** field, enter your name.
  3. In the **Call me at** (optional) field, enter your number.
  4. Click **Join** to join the conference.

**Note:**
• If you have not entered your call back number at the beginning, you can refresh the browser to navigate to the starting page and enter the number.
• Softphone, Agenda, screen sharing and individual chat are not supported for conferences on an iOS device.

After the conference ends, close the browser to leave the conference.

**Placing a Participant on Mute**

If you are an organizer of the conference, you can mute and unmute all participants or an individual participant.

• To mute all participants, click 🎤 icon on the conference task bar.
To unmute all participants, click icon on the conference task bar.

To mute a participant, click icon beside the participant name on the dashboard.

To unmute a participant, click icon beside the participant name on the dashboard.

Note: If you enable the Mute participants on entry option while creating the conference, the Mute-all option is automatically enabled and all the participants will be on mute when they join the conference. For more information about creating a conference, see Creating a Conference on page 55.

Dropping a Participant from Conference

Organizer can drop a participant from the conference.

To drop a participant, do one of the following on the dashboard:

1. Click icon below the participant name. In the confirmation dialog box, click Yes.
2. Right-click the contact and select Remove <user name>.

Recording a Conference

1. Dial in to join a conference.
2. Click on the conference task bar to start recording the conference. The REC icon turns red to indicate that recording is in progress.
3. When you want to stop recording, click REC.

You can stop a recording while a conference is in progress. To leave the conference, you must click the red call end icon as explained in Joining a Conference on page 59.

You can download, play or copy the recording URL.

1. On the Dashboard, click Events > Past.

The conference with recordings are indicated with REC.

2. In the second pane, select the conference.
3. In the third pane, click and select the required option.

Note: You can play the conference recordings on the Connect client and all web browsers except the Microsoft Internet Explorer 11.

Canceling a Conference

You can cancel a Connect conference any time through either the Connect client or Microsoft Outlook.

Canceling a Conference from the Connect client

1. Click the Events tab on the dashboard.
2. Click the Upcoming tab to view the list of future conferences. The list is sorted by date, from the current event to future events.
3. Click the conference that you want to cancel.
4. Click Cancel Event at the bottom of the third pane.
5. Click Cancel in the confirmation dialog box.

Note: The Canceling Event message is displayed at the bottom of the third pane. This message is followed by Opening Outlook Please Wait message, and the Outlook invite is launched (if you have integrated with Microsoft Exchange).
6. Click Send Cancellation in the Outlook invite cancellation window to notify participants of the cancellation.
Canceling a Conference from Microsoft Outlook

If you have integrated the Connect client with Microsoft Outlook, you can cancel a conference from the Outlook client.

1. Launch Microsoft Outlook.
2. Open the conference appointment in the Outlook calendar.
3. Click Cancel Meeting at the top left corner of the Outlook ribbon.
4. Click Send Cancellation to notify participants of the cancellation.

Conferencing using Connect client for Web

You can use the Connect client for Web to launch Connect conferencing without the Connect client. This feature is useful for remote users who have not installed the client on their systems.

By using the Connect client for Web, you can join a Connect conference from any non-Mitel network without entering any authentication details. Organizers joining the conference through the Connect client for Web can only serve as participants, not presenters or organizers in the meeting.

Using the Connect client for Web

1. Do one of the following in the meeting invite sent by the conference host:
   • Open the Link in a web browser.
   • Click the Click here to join link.
2. In the Introduce yourself as field, enter your name, and press Enter. The navigation pane on the left displays:
   • Meeting Title—the conference name
   • Now Sharing—the contact currently sharing the screen
   • Now Speaking—the contact currently speaking in the conference
   • Group Chat—public chat window for all conference participants
   • Attendees—list of participants in the conference
3. Click the task bar at the bottom of the page, and do one of the following:
   • To join the conference through the computer audio, click Call via Computer Audio.
   • To configure a call back, enter the number in the Call Me field, and click Call Me. Note: You can configure a call back only after the organizer joins the conference. If the organizer has not joined the conference, the Call Me option is disabled, and you see the message, Available after an organizer joins below the Call Me field.
4. You can perform the following actions during the conference using the icons on the task bar at the bottom of the page:
   • To leave the call during the conference, click .
   • To mute and unmute your audio during the call, click .
   • To share your screen, a portion of the screen, or an application window, click .
   • To view and copy the meeting information, click .
   • To ask a question during the conference, click .
5. After the conference ends, close the browser to leave the conference.

Optionally, you can use the dial-in info and the participant code given in the conference invitation to join the conference through your cell phone.

Using Group Chat

Messages from other users are indicated with a red pop-up. Click the group chat window or a participant’s name to view the message.

To send a message to the conference participants:
1. Click the Group Chat icon on the left navigation pane.
2. Enter your message in the IM input field at the bottom of the IM chat window, and click Enter.
You will receive IM message notifications with a red pop-out. Click the group chat window or participant’s name to view the message.

Using Screen Sharing
You can use the screen sharing feature to present your screen to the conference participants. You can share the entire screen, a portion of the screen, or an application window. The area being shared is outlined by a green rectangular border.

If the share icon is grayed out, your configuration might not support screen sharing. For more information, contact your Connect administrator.

Screen Sharing Methods describes the various ways to share the screen.

Figure 9 : Screen Sharing Methods

To share your screen with the conference participants:

1. On the Conference task bar, click 
2. To share an application window, select Share Window.
   To share the full screen, select Share Full Screen. To share a portion of the screen, select Share Area.
   If you are a first-time user, select the appropriate option when you are prompted to install the presenter software.
   Note: When you attempt to share the screen in the Microsoft Edge browser for the first-time, the Connect client for Web displays multiple pop-ups to install the Connect Presenter.
3. If you are the conference host, screen sharing is enabled immediately after the connect presenter is installed.

If you are a participant, the screen sharing request is sent to the host. Connect client displays a notification on the conference task bar for all screen sharing requests. If the system notification for screen share is enabled, the Connect client also displays the system notification. Host must click **Accept** on the notification to view your screen, or click **Reject**.

To receive a system notification for screen sharing requests, see Managing System Notification for Screen Sharing Request on page 66.

After the host accepts your screen share invite, the screen share will start immediately.

During screen share, the tool bar with the following options is displayed at the top of the screen:

- Conference name
- Screen share status
- Pause sharing
- End sharing

To collapse or expand the tool bar, click the arrow next to the conference name.

4. Click **○** to pause screen sharing.

5. Click **×** to stop sharing.

If another user starts to share the screen while you are sharing, your Connect presenter will exit and stop your screen sharing.

**Managing System Notification for Screen Sharing Request**

**Note:** By default, the system notification for screen sharing requests is enabled.

To disable the system notification for an incoming screen sharing request:

1. On the Dashboard, click the `<username>` tab.

2. On the second pane, click **○**.

3. Click **Notifications > Popup**.

4. Uncheck the **Show a system notification for incoming Screen Share** option.
Sharing Screen

This chapter provides information about sharing screens.

- **Sharing Screens with a Contact**

**Sharing Screens with a Contact**

The Connect client enables easy sharing of screens with a contact.

1. Click the **Contacts** tab or enter the contact name/number in the Quick Dialer Search bar on the dashboard.
2. From the search results, select the contact.
3. On the Contact card to the left of the Avatar, click to share your screen.
   
   **Note**: If you want to call your contact, before sharing your screen, see step 6.

4. Click:
   - **Share Full Screen**: To share your entire computer screen with your contact. The information displayed on your screen is visible to your contact.
   - **Share Area**: To share a movable rectangular area that you can use to share specific portions of your screen.
   - **Share Window**: To share any of the client application windows you have open on your computer. For example, you can choose to share only the Microsoft Outlook Email application window with your contact.

   A screen sharing invite is sent to your contact as a notification. The contact must click ✓ to accept viewing your screen, or click ✗ to reject the screen sharing invite.

   Optionally, if the contact card is open, click View Screen Share in the Actively Sharing pop-up notification to accept the screen share.

5. After the contact accepts your screen sharing, the screen share will start immediately. The screen area being shared is highlighted with a green rectangular border.

   To pause screen share, click 🕵️. The rectangular border marking the area being shared becomes orange.

6. To call or have a conference with your contact, click 📞 in the third pane (For information about using this feature, see **Joining a Conference**.

7. To end the screen sharing session, click 🗑 at the top of the screen.

   A notification is displayed in your contact's third pane that indicates that you are no longer sharing your screen.

   If your contact starts to share the screen while you are sharing, your Connect presenter will exit and stop your screen sharing.
Managing your Account

This chapter provides information about managing the Mitel Connect client user accounts.

- Setting a Sound Notification
- Managing History

Setting a Sound Notification

You can create a sound notification to identify a specific event, such as a voicemail, a call from an internal or external number, a monitored call, a shared call, or to identify a new or an existing conversation.

1. On the Dashboard, click the <username> tab.
2. For macOS, click Preferences.
   For Windows, click Settings.
3. Click Notifications > Sounds.
4. In the Audio Alerts field, select ON.
5. In the For event field, click the drop-down list on the right, and select any of the following:
   - new voicemail
   - call from an internal number
   - call from an external number
   - new IM message initiating a new conversation
   - new IM message initiating an existing conversation
   - monitored call
   - shared line call
6. Select Play alert, click the drop-down list on the right, and select a required sound from the list.
   Note: Other than the default list of sounds, you can also add or remove a new .wav file.

Managing History

You can view the history of your interactions for all your contacts at once or for only a specific contact.

Viewing Interaction History of all Contacts describes various methods to view interaction history of all contacts.

Figure 10 : Viewing Interaction History of all Contacts
Viewing your Interaction History for all Contacts

1. On the Dashboard, click the Recent tab.
2. Click the drop-down list on the top-right corner to filter for any specific interactions:
   - Everything
   - Calls
   - Voicemails
   - Messages

   You can search for a phrase within an IM history when a contact card is opened for a group or an individual in the IM history search in the IM input window.

3. To view your interaction history for all contacts, select Everything from the drop-down list, and click the All tab.
4. To view only missed interactions, select Everything from the drop-down list, and click the Missed tab.
5. To view flagged voicemails, select Everything or Voicemail from the drop-down list, and click the Flagged tab.
6. To view only deleted voicemails, select Everything or Voicemail from the drop-down list, and click the Deleted tab.
7. To view only the call interactions, select Calls from the drop-down list.
8. To view only the IM interactions, select Messages from the drop-down list.

Viewing your Interaction History for a Single Contact

1. Find a contact (For more information, see Managing Contacts on page 16).
2. To view all interactions from the history, select Everything from the drop-down list.
3. To view only call interactions with the contact from the history, select Calls from the drop-down list.

   Click on each call entry to see the details of origin of the call, duration of the call, call routing slip, and to enter any call note.
4. To view only the Voicemail interaction with the contact from the history, select Voicemails from the drop-down list.

   For more information about voicemail reply, forward, and delete, see the following sections:
   - Replying to a Voicemail Message on page 42
   - Forwarding a Voicemail Message on page 42
   - Deleting a Voicemail Message on page 43
5. To view only the IM interaction with the contact, select Messages from the drop-down list.
Managing Workgroups

This chapter provides information about managing workgroups using the Connect client.

- Workgroups Overview
- Managing Workgroups
- Setting Queue Monitor Alert Threshold

Workgroups Overview

Agents and supervisors can see the Workgroups tab on the Connect client dashboard if they belong to any workgroup. The Workgroups tab displays the active workgroup calls for a user, and the current workgroup state.

Following table lists the workgroups states of agents and supervisors.

**Table 5: Workgroups States of Agents and Supervisors**

<table>
<thead>
<tr>
<th>Color</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Logged In</td>
<td>Logged into the workgroups</td>
</tr>
<tr>
<td>Grey</td>
<td>Logged Out</td>
<td>Logged out of the workgroups</td>
</tr>
<tr>
<td>Orange</td>
<td>Wrap Up</td>
<td>Agent or Supervisor is performing wrap-up work for a workgroup call.</td>
</tr>
</tbody>
</table>

Workgroups Access Types

You must be a member of a workgroup and have necessary license type to view information about workgroups. Your license type determines what type of member you are.

Types of workgroup members are:

- **Agent**: These users have the Workgroup Agent license type and access to workgroup information, but not agent information.
- **Supervisor**: These users have the Workgroup Supervisor or Operator license type and access to all workgroup and agent information. They must also be members of a workgroup.

Identify Call by Workgroup Name

When a supervisor or an agent receives a call for a workgroup, the call notification on the dashboard displays the name of the workgroup. This helps users who are members of multiple workgroups to identify which workgroup is receiving a call.

Managing Workgroups

Viewing Workgroups Information

Click the Workgroups tab on the dashboard to view the following workgroup information in the second pane:

- Call Handling Mode icon—Shows the Call Handling Mode status
- Workgroup name—Name of the workgroup
- Queued Calls—Number of calls queued for the workgroup
- Longest Queued—Call that has been on hold for the longest period in the queue
- Longest Call—Call that has the longest call duration
To see the workgroup details, select a workgroup, and click Show Workgroup Details. For all the workgroups selected in the second pane, supervisor can view queued calls, agents and voicemail messages in the third pane. You can also select the workgroups by clicking Settings option at the bottom of the second pane.

**Assigning Call Handling Mode Status**

A supervisor can assign the Call Handling Mode status to the workgroup. To assign the Call Handling Mode status:

1. On the Dashboard, click the Workgroups tab.
2. In the second pane, click the Call Handling Mode icon beside the Workgroup name and select one of the following options:
   - On-Hours
   - Off-Hours
   - Holiday
   - Custom

The Workgroup Call Handling Mode status can be customized using the Custom mode. The Custom mode can be configured only from the Connect Director.

**Filtering Queued Calls**

Select the Queues tab in the third pane for queued calls details. When you filter the workgroup information by queued calls, you can see name of the caller or telephone number. If caller name is not associated with the call, the following information is displayed:

- Duration that the queued call has been in the workgroup
- Duration of the call in the system
- Dialed number
- Caller ID

**Note:** To pick calls from the queued calls list, agents and supervisors must select Allow agents to pickup from queue option in Connect Director.

**Managing Agents**

A Supervisor can manage the Workgroup agents from the Agents tab on the third pane. The Agents tab is visible only to the supervisors and they can perform all actions without logging in to the Workgroups.

- To search for an agent, select the Agents tab on the third pane, and type the agent name or extension number in the Search field.
- To change the status of the agents of all Workgroups:
  1. On the Dashboard, click the Workgroups tab.
  2. On the second pane, click Show Workgroup Details.
  3. On the third pane, select the Agents tab. By default, in the drop-down list on the left, All is selected. If another Workgroup is selected, click the drop-down icon and select All.
  4. Click Set As.
  5. From the drop-down list, select the required status:
      - Logged In
      - Logged Out
      - Wrap-Up (this option is available only when the agents are logged in to the Workgroup)
      - End Wrap-Up

- To change the status of the agents of a single Workgroup:
  1. On the Dashboard, click the Workgroups tab.
  2. On the second pane, click Show Workgroup Details.
  3. On the third pane, select the Agents tab. Click the drop-down icon on the left, and select the Workgroup.
  4. To change the status of all agents in the selected Workgroup, click Set As and select the required status.
To change the status of a single agent in the selected Workgroup:

- Click the availability state icon below the agent name and select the required status.
- In the Search field, type the name or extension number of the agent, and click Set As and select the required status.

If the search result displays more than one agent, using the Set As option changes the status of all the agents in the search result.

**Note:** When the Supervisor changes the status of all agents, the status of the Supervisor remains unchanged.

Supervisors can control the following actions for a single agent without logging in to the Workgroup:

- Call an agent
- Check voicemail
- Log in an agent
- Log off an agent
- Put the agent in Wrap Up state (this option is available only when the agent is logged in to the Workgroup)
- Change the Availability state of an agent

With the proper permissions configured by the Connect administrator, supervisors can also perform the following actions on agents:

- Pick up a call
- Add and manage call notes
- View routing slips
- Unpark call
- Intercom
- Whisper page the agent
- Silent coach the agent
- Barge in on the agent
- Silent monitor the agent
- Setting a Sound Notification
- Enable picking up calls and parking calls

**Accessing Workgroups Voicemails**

Supervisors and agents can view and listen to the workgroup voicemails without logging into the workgroup.

1. On the Dashboard, click the Workgroups tab.
2. In the second pane, click Show Workgroup Details.
3. In the third pane, click the Voicemails tab to view workgroup voicemails. The unheard voicemails appear in bold font with an orange dot indicator.
4. Select a voicemail and click 🎧 to play the voicemail through the computer speaker or 📞 to play through the desk phone, and click 🎧.

**Note:** If you have assigned your Connect client to Softphone, desk phone option will not be displayed.

By default, the Voicemail tab displays the voicemails of all the workgroups you belong to. You can filter the voicemails list to view voicemails by workgroup.

To view voicemails by workgroup, click the drop-down list on the Voicemail tab in the third pane and select the workgroup.

**Note:** After you exit and reopen the workgroup, the drop-down selection changes to the default value, “All”.

The Deleted Voicemails tab is displayed only if there are any deleted voicemails. By default, this tab is in collapsed view. Click ✔️ on the Deleted Voicemails header to view the deleted voicemails.
To restore a deleted voicemail of the workgroup, locate the voicemail in the Deleted Voicemails list of the workgroup and click Restore.

**Configuring Workgroup Notifications**

To configure the workgroup notifications:

1. On the Dashboard, click the `<username>` tab.
2. On the second pane, click 
3. Click Workgroups.
4. Select Show me notifications when calls arrive in queue to view the notifications for the queued calls.
   
Enter the time duration in the Keep the notification on screen for field to set the time for displaying the notifications on the screen.
5. Select Continue to show notification while logged out of workgroups to view the workgroup notifications after you log out.

**Setting Queue Monitor Alert Threshold**

To specify the queue monitor alert thresholds and call arrive in queue notification, click Settings at the bottom of the second pane. You can also access Workgroup settings by:

1. On the dashboard, click the `<username>` tab.
2. On the second pane, click 
3. Click Workgroups.

Supervisor can view all workgroups configured and edit Alert Thresholds for each workgroup. However, agents can view only Alert Thresholds. Closing the preferences window or switching to another tab saves your threshold settings.

When the specified workgroup queue thresholds are exceeded, the queued calls number and/or call duration label color changes to red in the second pane. After the parameter drops below the threshold, the label color changes back to default gray. When the queue threshold exceeds the specified time and number, a sound is played. You can turn the sound on or off using the Bell icon at the bottom of the second pane.

To configure Queue Monitor Alert Threshold:

1. On the dashboard, click the `<username>` tab.
2. On the second pane, click 
3. Click Workgroups.
4. Select the Enable Workgroup option for the required workgroup to configure queue monitor alert threshold.
5. In the Turn ON Threshold Alert field, select the required workgroup to enable the threshold alert.
6. In the Alert When Queue Reaches or Exceeds field, increase or decrease the call queue number for the required workgroup.

   This number determines the number of calls that can be queued before sending an alert to the user.
7. If required, in the Alert When Queued Time Exceeds field, enter the time duration to set the queue monitor alert threshold for the workgroup.
Accessing MiTeam Meetings

About MiTeam Meetings
MiTeam Meetings is a cloud-based video collaboration tool (based on CloudLink infrastructure) that enables Connect Client users to access features, such as:

- **Collaborate**: Perform audio, video, and web sharing
- **Chat**: Hold chat sessions and receive chat notifications within the meeting

**Note:**
- To provision MiTeam Meetings for Connect Client users, Mitel Partners must first create Customer accounts in the CloudLink Account Console, and then add users (Connect Client users) to that account. For more information, see the Provisioning MiTeam Meetings for MiVoice Connect section in the MiVoice Connect MiTeam Meetings Solution Document for Connect Client located at https://www.mitel.com/document-center/business-phone-systems/mivoice-connect/connect-client.
- After the Mitel Partner provisions MiTeam Meetings, the users must register their MiTeam Meetings account. For more information, see Registering the MiTeam Meetings Account on page 75.
- The users can cross launch the MiTeam Meetings application from Connect Client. For more information, see Launching MiTeam Meetings from Connect Client on page 77.
- Registering the MiTeam Meetings Account
- Launching MiTeam Meetings from Connect Client

Registering the MiTeam Meetings Account
To register your MiTeam Meetings account, follow these steps:

1. Ensure that you have received an e-mail bearing the subject line Welcome to Mitel from no-reply@mitel.io.

   This is a verification e-mail sent to you when the administrator adds you as a user in the CloudLink Accounts Console. If you do not find this e-mail in your mailbox, check your Junk or Spam folders for recent e-mails sent to you from no-reply@mitel.io.

   **Note**: The link provided in the welcome email will expire after 4 days and can be used only once.

2. In the Welcome email, select **Finish building your account**.

   **Figure 11**: Finish building your account option
3. In the window that opens, users must create a new password for the Mitel Accounts and click **Complete** to complete the registration process.

**Figure 12 : Completing the registration process**

4. In the window that opens, it is recommended that you enter the mobile number in the **Add your mobile number** field.
5. Select **Submit** to register the account.

**Figure 13 : Registering the account**
Launching MiTeam Meetings from Connect Client

**Note:**

- To launch the MiTeam Meetings application from Connect Client, it is mandatory that you must have installed the MiTeam Meetings application on your system.
- When the MiTeam Meetings application installed on a client machine, the Meetings icon becomes active in the Connect Client menu. If the application is not installed on a client machine, then the icon will be greyed out and inactive.

After you successfully register MiTeam Meetings, you can launch MiTeam Meetings application from Connect Client by following these steps:

1. On your desktop, click the **Mitel Connect** icon and complete the following fields to log in:
   - **User name**
   - **Password**
   - **Domain**
2. The Connect Client application opens where you will see that the **Meetings** option is now enabled.

**Figure 14 : Miteam Meetings on Connect Client**
3. Click the **MiTeam Meetings** icon to launch MiTeam Meetings application.
## Operator Features

This chapter provides information on how to enable, and access operator specific features.

Connect Operator license provides the operators with additional features and functionalities within the Connect client that makes easier to manage large volume of calls within the application.


Connect client provides special features for operators as listed in the following table.

### Table 6: Operator Features Overview

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag and drop</td>
<td>Operators can left-click and drag an object in both the directions; from call stack to a contact and vice versa.</td>
</tr>
<tr>
<td>Drag and hover</td>
<td>Operators can left-click and hover an object in both the directions; from call stack to a contact and vice versa to access more telephony functions. The advanced telephony functions are:</td>
</tr>
<tr>
<td></td>
<td>• Blind Transfer</td>
</tr>
<tr>
<td></td>
<td>• Consultative Transfer</td>
</tr>
<tr>
<td></td>
<td>• Intercom Transfer</td>
</tr>
<tr>
<td></td>
<td>• Transfer to Mailbox</td>
</tr>
<tr>
<td></td>
<td>• Park</td>
</tr>
<tr>
<td></td>
<td>• Park and Page</td>
</tr>
<tr>
<td></td>
<td>• Park and Intercom</td>
</tr>
<tr>
<td></td>
<td>• Blind Conference</td>
</tr>
<tr>
<td></td>
<td>• Consultative Conference</td>
</tr>
<tr>
<td></td>
<td>• Intercom Conference</td>
</tr>
<tr>
<td></td>
<td>• For more information, refer to <a href="#">Transferring a Call</a></td>
</tr>
<tr>
<td>Call stack orientation</td>
<td>Operators can view the oldest call at the top of the call stack and the most recent call at the bottom.</td>
</tr>
<tr>
<td>Double click to answer</td>
<td>To answer an incoming call, operators can:</td>
</tr>
<tr>
<td></td>
<td>• Double-click anywhere in the incoming call notification area.</td>
</tr>
<tr>
<td></td>
<td>• Click the green call icon as other users.</td>
</tr>
<tr>
<td>Routing slip</td>
<td>Operators can view or hide the routing slip for each call by toggling the routing slip icon in the incoming call notification area.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>Routing slip is disabled by default.</td>
</tr>
<tr>
<td></td>
<td>To enable routing slip, refer to <a href="#">Managing Call Notes and Viewing Routing Slips</a></td>
</tr>
</tbody>
</table>
## Features

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing availability state of a contact</td>
<td>Operators can change a contact’s availability state if:</td>
</tr>
<tr>
<td></td>
<td>• Contact belongs to the contact group created by operator.</td>
</tr>
<tr>
<td></td>
<td>• Contact has added operator on his access list.</td>
</tr>
<tr>
<td></td>
<td>To add a contact to access list, refer <strong>Allowing a Contact to Manage your Availability State</strong>.</td>
</tr>
<tr>
<td></td>
<td>To change a contact's availability state, do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Right-click a contact, and select Change Availability &lt;availability state&gt;.</td>
</tr>
<tr>
<td></td>
<td>• Open the contact card by selecting a contact, click on the arrow next to contact’s availability state, and select the state.</td>
</tr>
<tr>
<td>Identifying the call by workgroup name</td>
<td>When an operator receives a call for a workgroup, the call notification on the dashboard displays the name of the workgroup. This helps users who are members of multiple workgroups to identify which workgroup is receiving a call.</td>
</tr>
</tbody>
</table>